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1 Willkommen zu REAKTOR
 

REAKTOR ist ein Musikinstrument. Es dient zur Erzeugung von Sounds. Sie können es, 
wie jede andere Musik-Software, im Standalone-Modus mit einem MIDI-Keyboard spielen 
oder als Plug-in in einer Sequenzer-Umgebung betreiben.
Sie selbst können die Art des Musikinstruments bestimmen. Jedes Mal, wenn Sie REAK
TOR starten, können Sie es Ihren musikalischen Bedürfnissen anpassen. Sie brauchen ei
nen Synthesizer? Sie brauchen einen Drumcomputer? Sie brauchen einen Krachmacher, 
den niemand zuvor je gehört hat? Laden Sie einfach das entsprechende Instrument und 
spielen Sie es.
Die Vollversion von REAKTOR ist mit mehr als 50 Instrumenten ausgestattet. Im Lieferum
fang befindet sich eine Sammlung von Instrumenten früherer REAKTOR-Versionen, die in 
einem Zeitraum von über zehn Jahren entstanden sind und elektronische Musikproduktio
nen maßgeblich geprägt haben. Die Online-Bibliothek umfasst mehr als 3000 Instrumente 
mit allem, was Sie sich vorstellen können.
Wenn Sie nicht im Besitz der Vollversion sind, können Sie trotzdem die musikalische Kraft 
der REAKTOR Engine nutzen. Eine beständig anwachsende Sammlung von KOMPLETE-In
strumenten wird separat für REAKTOR angeboten. Wenn Sie eines dieser Instrumente la
den, schaltet REAKTOR in den Player-Modus. Das wird im Abschnitt ↑1.2, REAKTOR-Mo
di: Full, Player und Demo näher erläutert.
Das Laden vorgefertigter Instrumente streift aber nur die Oberfläche. Sie können den Sig
nalfluss Ihres bevorzugten Instruments bearbeiten, die interne Struktur einer songspezifi
schen Verwendung anpassen oder ein Instrument von Grund auf neu zusammenbauen und 
dabei Ihre persönlichen Klangpräferenzen berücksichtigen.
Diese Kurzanleitung hilft Ihnen beim Einstieg.
Ihr Native Instruments REAKTOR-Team

1.1 Systemanforderungen
 

Für die aktuellen Systemanforderungen, sowie Informationen über Kompatibilität und mit 
aktuellen und älteren Betriebssystemen besuchen Sie bitte unsere Website unter:
www.native-instruments.com/REAKTOR

Willkommen zu REAKTOR
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1.2 REAKTOR-Modi: Full, Player und Demo
 

Der Funktionsumfang, der auf Ihrem Computer installierten Version von REAKTOR, ist ab
hängig von dem Modus in dem REAKTOR betrieben wird. Der Modus ist von der Lizenz 
abhängig, die Sie verwenden:

▪ Full mode (Vollversion): Wenn Sie REAKTOR als Einzelprodukt oder Bestandteil eines 
Bundels wie KOMPLETE bereits installiert und aktiviert haben, verwenden Sie die 
Vollversion. In der Vollversion stehen alle Funktionen ohne Restriktionen zur Verfü
gung.

▪ Player mode (Player-Modus): Sie haben eines der KOMPLETE-Instrumente für REAK
TOR oder ein Bundle dieser Instrumente wie KOMPLETE Elements installiert und ak
tiviert. Zusätzlich haben Sie REAKTOR als Player für diese Instrumente installiert. In 
diesem Fall nutzen Sie REAKTOR im Player-Modus. Im Player-Modus können Sie In
strumente spielen und ihre Einstellungen ändern, aber nicht die interne Struktur. Da 
der Player-Modus von REAKTOR das Speichern der Instrumente nicht unterstützt, 
werden diese Einstellungen in Ihrem Host-Programm gesichert.

▪ Demo mode (Demo-Modus): Sie haben REAKTOR und ein paar KOMPLETE-Instrumen
te als Demoversionen installiert, aber keine dieser Produkte aktiviert. In diesem Fall 
nutzen Sie die Demo-Lizenz von REAKTOR und betreiben REAKTOR im Demo-Mo
dus. Im Demo-Modus stehen Ihnen alle Funktionen zur Verfügung, aber die Anwen
dung stoppt die Audioausgabe nach 30 Minuten. Außerdem ist steht die Speicher
funktion nicht zur Verfügung.

Die Installation und Aktivierung der Software ist ausführlich im separaten Native Instruments 
Setup Guide beschrieben.

1.3 Über dieses Handbuch
 

Dieses Handbuch erklärt alle notwendigen Schritte, um mit der Arbeit von REAKTOR zu 
beginnen:

▪ Die Kapitel ↑2, Grundeinstellungen in REAKTOR und ↑3, Laden und Spielen be
schreiben, wie Sie die Anwendung einrichten, ein Instrument laden und spielen. Die
ser Teil des Handbuchs für jeden Nutzer relevant.

Willkommen zu REAKTOR
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▪ Die Kapitel ↑4, Bearbeitung eines REAKTOR-Ensembles bis ↑9, Wie geht es weiter? 
behandeln Funktionen, die nur in der Vollversion von REAKTOR zur Verfügung ste
hen. Wenn Sie den Player-Modus von REAKTOR verwenden, ist dieser Teil für Sie 
nicht relevant.

Die Unterweisungen in den folgenden Kapiteln, machen Sie mit den grundlegenden Ar
beitsschritten von REAKTOR vertraut. Ohne Sie mit technischen Details zu langweilen, er
fahren Sie in einer Reihe von Tutorials, wie Sie die Möglichkeiten von REAKTOR effektiv 
nutzen können. Arbeiten Sie die Tutorials bitte in der vorgegebenen Reihenfolge durch, da 
sich später folgende Abschnitte auf zuvor behandelte Themen beziehen.

1.4 Die REAKTOR Dokumentation
 

Wenn Sie einmal mit den Basisfunktionen von REAKTOR vertraut geworden sind, wollen 
Sie vielleicht noch mehr erfahren. Das REAKTOR-Referenz-Handbuch beinhaltet detaillier
te Beschreibungen aller relevanter Abläufe und Funktionen von REAKTOR:

▪ Das Anwendungs-Referenz-Handbuch (Application Reference) erklärt alle elementaren 
Konzepte von REAKTOR. Sie erfahren detailliert, wie Sie die Anwendung bedienen. 
Wenn Sie die Möglichkeiten von REAKTOR über das im Getting-Startet-Handbuch Be
schriebene hinaus nutzen und verstehen möchten, sollten Sie sich mit dem Anwen
dungs-Referenz-Handbuch auseinandersetzen.

▪ Das Instrument-Referenz-Handbuch (Instrument Reference) beschreibt alle Instrumen
te, die im Lieferumfang von REAKTOR enthalten sind. Lesen Sie dieses, wenn Sie et
was über die musikalischen Möglichkeiten jedes einzelnen Instruments im Detail er
fahren möchten.

▪ Im Modul- und Macro-Referenz-Handbuch (Module and Macro Reference) sind Infor
mationen über alle verfügbaren Bauteile enthalten, die für die Konstruktion eigener 
Instrumente in REAKTOR genutzt werden können. Wenn Sie die ausgetretenen Pfade 
verlassen möchten, ist dies das richtige Handbuch für Sie.

▪ Das Core-Referenz-Handbuch (Core Reference) letztendlich, ist in zwei Teile unterteilt: 
Die erste Hälfte enthält ein Tutorial, in dem der Core-Level von REAKTOR beschrie
ben und Ihnen vermittelt wird, wie Sie Ihre eigenen "low-level"-Geräte zur Verarbei
tung digitaler Signale erstellen können . Der zweite Teil besteht aus einer Referenz, in 
der alle Core-Level-Komponenten umfassend erfasst sind.

Willkommen zu REAKTOR
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Diese Handbücher sind am nützlichsten, wenn Sie REAKTOR in der Vollversion betreiben. 
Da Ihnen das Anwendungs-Referenz-Handbuch ein weitreichendes Verständnis bezüglich 
der Nutzung der REAKTOR-Instrumente vermittelt, sollten Sie dieses auch dann zu Rate 
ziehen, wenn Sie REAKTOR im Player-Modus betreiben.

Sie erhalten diese Handbücher über das Help-Menü von REAKTOR.

In Ergänzung, der zum Lieferumfang von REAKTOR gehörenden Handbücher, finden Sie 
weitere Informationen online: Besuchen Sie das Native Instruments Anwender-Forum un
ter
http://www.native-instruments.com/forum/
Die riesige REAKTOR-Gemeinde tauscht Tipps und Tricks aus und hilft Ihnen bei speziel
len Fragen.

1.5 Spezielle Formatierungen dieses Handbuchs
 

In diesem Handbuch werden spezielle Formatierungen verwendet, um Sie auf Besonder
heiten oder mögliche Probleme hinzuweisen. Die Symbole neben den Randbemerkungen 
zeigen, um welche Art von Informationen es sich handelt:

Lesen Sie die mit einem Ausrufezeichen gekennzeichneten Hinweise immer aufmerksam 
durch und folgen Sie den dort angeführten Anweisungen.

Willkommen zu REAKTOR
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Dieses Glühbirnen-Symbol weist auf eine Randbemerkung mit nützlicher Zusatzinformati
on hin. Solche Informationen können Ihnen beispielsweise helfen, eine Aufgabe schneller 
zu lösen, sie sind aber nicht in jedem Fall auf das von Ihnen gerade verwendete Betriebs
system oder Setup anwendbar. Meistens dürfte es sich allerdings lohnen, einen Blick da
rauf zu werfen.

Willkommen zu REAKTOR
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2 Grundeinstellungen in REAKTOR
 

REAKTOR 5 kann im Stand-Alone-Modus betrieben werden und besitzt dann eine eigene 
Schnittstelle zu Ihrer Audio- und MIDI-Hardware. Wenn Sie diesen Modus benutzen, kön
nen Sie REAKTORmit einem MIDI-Keyboard oder -Controller steuern. Nachfolgend gehen 
wir davon aus, dass Sie REAKTOR im Stand-Alone-Modus betreiben.
In diesem Kapitel erfahren Sie, wie Sie REAKTOR mit MIDI-Geräten und der Audio-Hard
ware kombinieren, die an Ihrem Computer angeschlossen ist. Sie werden außerdem REAK
TOR näher kennenlernen, ohne Ablenkung durch das Musikmachen mit Ihrer DAW.
Bevor Sie die Arbeit mit REAKTOR 5 aufnehmen, sollten Sie seine Audio- und MIDI-Vor
einstellungen Ihren Bedürfnissen anpassen.
Dies gilt nur für die Stand-Alone-Anwendung von REAKTOR 5, denn bei den REAKTOR-
Plug-ins kümmert sich die Host-Anwendung um diese Dinge.

2.1 Einrichten der Audio-Hardware
 

Um den von REAKTOR generierten Sound hörbar zu machen, müssen Sie Ihre Audio-
Hardware (zum Beispiel Ihre Soundkarte oder Ihr externes Audio-Interface) für die Verwen
dung mit REAKTOR einrichten.

Benutzen Sie Niedriglatenztreiber (Low-Latency Drivers)
Wenn möglich, sollten Sie bei der Arbeit mit REAKTOR Treiber mit niedriger Latenz be
nutzen. REAKTOR arbeitet mit zwei Arten von Niedrig-Latenz-Treibern zusammen:

▪ ASIO™
▪ Core Audio™ (nur auf Rechnern mit Mac OS® X)

Diese beiden Treiber-Technologien ermöglichen eine effiziente Datenübertragung zwischen 
Software und Audio-Hardware und sollten zu erträglichen bis unhörbaren Latenzen wäh
rend des Spiels führen.

2.1.1 Den Dialog Audio and MIDI Settings… öffnen
 

Wenn Sie REAKTOR zum ersten mal starten, sollte sich der Dialog "Audio and MIDI Set
tings..." öffnen. Sie können diesen Dialog zu einem späteren Zeitpunkt innerhalb von RE
AKTOR aufrufen:

Grundeinstellungen in REAKTOR
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1. Klicken Sie den Menu Button, um das Anwendungsmenü zu öffnen.

2. Wählen Sie in den Menü-Eintrag "File > Audio and MIDI Settings…":

2.1.2 Auswählen der Audio-Hardware
 

Um Ihre Audio-Hardware auszuwählen, die Sie mit REAKTOR verwenden möchten:
1. Doppelklicken Sie auf das REAKTOR-Symbol, um das Programm zu starten. Nun öff

net sich der „Audio and MIDI Settings...“-Dialog.
2. Klicken Sie im Audio-and-MIDI-Einstellungs-Dialog in das Device-Menü, um eine Liste 

mit den verfügbaren Audio-Interfaces zu öffnen. Wenn nur ein Audio-Hardware-Gerät 
zur Verfügung steht, wird dieses inklusive der Sample-Rate automatisch ausgewählt. 
Wenn zwei oder mehr Geräte auf Ihrem Computer installiert sind, wählen Sie das Ge
rät, das Sie mit REAKTOR verwenden möchten, indem Sie auf dessen Eintrag im De
vice-Menü klicken.

Grundeinstellungen in REAKTOR
Einrichten der Audio-Hardware
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3. Wählen Sie den gewünschten Treiber aus dem Driver-Menü. Auf Windows®-Computern 
wird die Verwendung von ASIO™-Treiber dringend empfohlen. Bei Computern, die 
mit Mac OS® X, betrieben werden ist Core Audio™ voreingestellt.

Grundeinstellungen in REAKTOR
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Fahren Sie nach der Auswahl des Audio-Hardware-Geräts und des zugehörigen Treibers 
mit der Audio-Hardware-Einrichtung fort und selektieren Sie die Sample Rate.

2.1.3 Auswahl der Sample Rate
 

1. Wählen Sie die gewünschte Sample Rate aus dem Sample Rate Menu. Wir empfehlen 
eine Sample Rate von 44100 Hz.

Grundeinstellungen in REAKTOR
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2. Fahren Sie nach der Auswahl der Sample Rate mit der Audio-Hardware-Einrichtung 
fort und selektieren Sie die Ausgangs-Latenz.

2.1.4 Anpassen der Ausgangs-Latenz
 

Durch die Anpassung der Ausgangs-Latenz können Sie festlegen, wie schnell das von RE
AKTOR generierte Audio-Signal zu hören ist, nachdem Sie eine Taste auf Ihrem MIDI-Key
board gedrückt haben. Die kleinste einstellbare Latenzzeit, bei der es nicht zu Knacksern 
oder anderen Störgeräuschen kommt, ist abhängig von der, für die Audio-Prozesse zur Ver
fügung stehenden CPU-Leistung. Bei einem modernen, korrekt installierten Computer, 
sollte es kein spürbaren Verzögerungen geben. Ältere Computer benötigen entspantere La
tenzeinstellungen. Die Art der Latenzeinstellung ist abhängig von Ihrem verwendeten Be
triebssystem.

Grundeinstellungen in REAKTOR
Einrichten der Audio-Hardware
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Windows®
1. Um das Kontrollfeld Ihrer Audio-Hardware zu öffnen, klicken Sie bitte auf den ASIO 

Config Button im Audio-and-MIDI-Einstellungs-Dialog.

2. Wählen Sie im Kontrollfeld Ihrer Audio-Hardware eine Ausgangs-Latenz von circa 
10 ms. Diese Einstellung sollte auf den meisten Computer-Systemen funktionieren.

Grundeinstellungen in REAKTOR
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3. Um die gewählten Einstellungen zu übernehmen, klicken Sie OK.

Mac OS® X
1. Bewegen Sie den Latency-Schieberegler im unteren Teil der "Audio and MIDI Set

tings..." auf einen Wert von 256 Samples.

Grundeinstellungen in REAKTOR
Einrichten der Audio-Hardware

 

REAKTOR 5.5 - Erste Schritte - 21



2. Um die gewählten Einstellungen zu übernehmen, klicken Sie OK.

2.1.5 Routing: Zuweisung der REAKTOR-Eingänge
 

Sie können jeden REAKTOR-Eingangskanal einem beliebigen Eingang Ihres Audio-Geräts 
zuweisen:
1. Klicken Sie im "Audio and MIDI Settings"-Dialog oben auf den Routing Tab (wenn Sie 

mit Mac OS® X arbeiten und die eingebauten Eingänge Ihres Macs nutzen möchten, 
müssen Sie ein Aggregate Device mit Hilfe des Dienstprogramms „Audio MIDI Set
up.app.“ erzeugen).

2. Klicken Sie auf den Inputs Button, um die Eingänge anzuzeigen.
3. Um einen REAKTOR-Eingang einem Eingang Ihrer Audio-Hardware zuzuweisen, kli

cken Sie auf den entsprechenden Eintrag in der rechten Spalte der Inputs-Darstel
lung.

Grundeinstellungen in REAKTOR
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4. Um die gewählten Einstellungen zu übernehmen, klicken Sie OK.

2.1.6 Routing: Zuweisung der REAKTOR-Ausgänge
 

Sie können jeden REAKTOR-Ausgangskanal einem beliebigen Ausgang Ihres Audio-Geräts 
zuweisen:
1. Klicken Sie im "Audio and MIDI Settings"-Dialog auf den Routing Tab (wenn Sie mit 

Mac OS® X arbeiten und die eingebauten Eingänge Ihres Macs nutzen möchten, 
müssen Sie ein Aggregate Device mit Hilfe des Dienstprogramms „Audio MIDI Set
up.app.“ erzeugen).

2. Klicken Sie auf den Outputs Button, um die Ausgänge anzuzeigen.
3. Um einen REAKTOR-Ausgang einem Ausgang Ihrer Audio-Hardware zuzuweisen, kli

cken Sie auf den entsprechenden Eintrag in der rechten Spalte der Outputs-Darstel
lung.

Grundeinstellungen in REAKTOR
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4. Um die gewählten Einstellungen zu übernehmen, klicken Sie OK.

2.2 Einrichten der MIDI-Hardware
 

1. Klicken Sie im "Audio and MIDI Settings"-Dialog auf den MIDI Tab. Auch hier werden 
Ihnen eine Reihe von Geräten angezeigt, die an Ihren Computer angeschlossen sind.

2. Klicken Sie auf das Textfeld Off neben dem Gerät Ihrer Wahl. Neben den Geräten, die 
Sie verwenden wollen, sollte das Textfeld die Bezeichnung On tragen.

Grundeinstellungen in REAKTOR
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3 Laden und Spielen
 

In diesem Tutorial erfahren Sie, wie vorhandene Instrumente geladen und gespielt werden.
▪ Wir zeigen Ihnen, wie Sie den REAKTOR Browser benutzen können, um REAKTOR 

Ensembles zu laden.
▪ Wir schauen uns Snapshots näher an.
▪ Zu guter Letzt werfen wir noch einen Blick auf das Speichern Ihrer Arbeit.

In diesem Tutorial gehen wir davon aus, dass Sie REAKTOR bereits installiert haben und 
zusätzlich die frei verfügbare REAKTOR Factory Selection, die zur Sammlung der KOM
PLETE Instruments gehört. Wir gehen außerdem davon aus, dass Sie REAKTOR als Plug-
in in Ihrem bevorzugten Sequenzer-Programm einsetzen.

Wenn Sie die Vollversion von REAKTOR besitzen, brauchen Sie das REAKTOR-Factory-Selec
tion Paket nicht zu installieren: Das Instrument Carbon 2, das wir in diesem Beispiel verwen
den möchten, ist Bestandteil des Lieferumfangs und befindet sich in New Additions > Synthe
sizers.

3.1 Wichtige Buttons
 

Bevor wir anfangen, sollten Sie sich mit den vier sehr wichtigen Buttons im Hauptmenü 
und der Sidepane (Seitenleiste) vertraut machen.

▪ Der Sidepane Button im Hauptmenü dient zum Öffnen und Schließen der Sidepane. 
Die Sidepane befindet sich dort, wo der Browser, die Snapshots, die Panelsets und die Pro
perties Tabs untergebracht sind.

Abb. 3.1 Der Sidepane Button

▪ Mit dem Browser Tab öffnen Sie den Browser, der zum Finden der in REAKTOR be
nutzten Files dient.

Abb. 3.2 Der Browser Tab
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▪ Mit dem Snapshot Button öffnen Sie den Snapshot Browser, der zum Auswählen, Spei
chern und Morphen von Presets dient.

Abb. 3.3 Der Snapshot Button

▪ Von hier ab möchten wir immer den Menu Button verwenden, um globale Menü-Einträ
ge zu erreichen. Alle diese Menü-Einträge lassen sich auch aus dem Applikationsme
nü heraus öffnen.

Abb. 3.4 Der Menu Button

Abb. 3.5 Das File-Menü (in der Windows®-Version)
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Es ist möglich, alle Ansichten in REAKTOR über das globale View-Menü zu erreichen. Um 
sich nicht zu sehr in Details zu verlieren, soll dieser Punkt in diesem Teil des Getting-Started-
Handbuchs nur kurz erwähnt werden.

Wir werden diese Buttons in unserem Tutorial einsetzen. Jetzt wollen wir den Browser be
nutzen, um das erste REAKTOR Ensemble zu laden.

3.2 Ensembles, Instrumente und KOMPLETE-Instrumente
 

Abgesehen von den Buttons, sollten Sie sich mit den folgenden Begriffen vertraut machen, 
da diese in der REAKTOR-Gemeinde zum Einsatz kommen und in diesen Tutorials vorkom
men:

▪ Ein Ensemble ist eine Gruppen von Instrumenten, die direkt in REAKTOR geladen 
werden können. Es kann sich dabei um einen einzelnen Synthesizer aber auch um ei
nen kompletten Kanalzug mit verschiedenen Effekten handeln. Die Instrumente sind 
untereinander verbunden und mit den Audio-Ein- und Ausgängen der Applikation ver
knüpft. Verwenden Sie für das Speichern typischer Weise das Ensemble-File-Format.

▪ Ein Instrument ist ein Teil eines Ensembles, wie zum Beispiel eine einfache Delay-Ef
fekteinheit. Sie können Instrumente in ein Ensemble laden, um sie mit den Audio-
Ein- und Ausgängen der Applikation zu verbinden.

▪ Das KOMPLETE Instrument ist die einzige Datei, die Sie mit der Player-Lizenz verwen
den können. Technisch ähnelt dieses einem Ensemble (es verbindet beispielsweise 
ebenfalls die Eingänge und Ausgänge) und wird als Instrument bezeichnet, das es aus 
musikalischer Sicht eine Einheit darstellt.

3.3 Carbon 2 laden
 

Im ersten Schritt möchten wir Carbon 2 öffnen, einen subtraktiven Synthesizer, der in der 
REAKTOR Factory Library enthalten ist.

3.3.1 Öffnen der Sidepane
 

Sollte die Sidepane nach dem Starten des Programms nicht geöffnet sein, müssen Sie die
se jetzt öffnen, da sie den File Browser von REAKTOR beinhaltet. Um die Sidepane zu öff
nen und zu schließenden, drücken Sie bitte auf den Sidepane Button im Hauptmenü.
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Abb. 3.6 Der Sidepane Button

3.3.2 Öffnen des Browsers
 

Klicken Sie bei geöffneter Sidepane auf den Browser Tab oder drücken Sie [F5] auf Ihrer 
Computer-Tastatur.

Abb. 3.7 Der Browser Tab

Dieser Vorgang zeigt den Datei-Browser in der Sidepane. Er ist in drei Teile unterteilt: Im 
oberen Bereich gibt es vier Buttons, um vier verschiedene Inhalte anzeigen zu können. Da
runter befindet sich der Ordner-Baum. Im unteren Teil befindet sich eine Liste mit Datei
en, des im Ordner-Baum ausgewählten Ordners.
Klicken Sie den Player Button oben im Browser. Es werden daraufhin alle installierten 
KOMPLETE Instruments im oberen Bereich angezeigt. Wählen Sie das REAKTOR-Factory-
Selection-Paket mit einem Mausklick aus.
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Abb. 3.1 Der Browser mit gewählter Factory Selection

Der Button neben dem Player Button ändert seine Bezeichnung, in Abhängigkeit der gewähl
ten REAKTOR-Aktivität: Nach der Aktivierung von REAKTOR beinhaltet er den Factory Con
tent von REAKTOR und ist mit "Factory" bezeichnet. Zuvor ist trägt er die Bezeichung "Demo". 
Das weist darauf hin, dass REAKTOR in den Demo-Modus wechselt, wenn Sie ein Ensemble 
von dort aus laden.
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3.3.3 Laden einer Datei
 

Wenn Sie die REAKTOR Factory Selection ausgewählt haben, werden die zugehörigen In
strumente im unteren Teil des Browser aufgelistet. Klicken Sie auf den Eintrag Carbon 2 
und ziehen Sie ihn in den Hauptbereich der Applikation. REAKTOR lädt daraufhin die Da
tei.

3.4 Carbon 2 und seine Snapshots spielen
 

Abb. 3. 2 Carbon 2 im REAKTOR PLAYER

Carbon 2 ist ein klassischen subtraktiver Synthesizer mit Bereichen für Oszillatoren, Filter, 
Modulationsquellen und integrierten Effekteinheiten.
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Informieren Sie sich im Instrument-Referenz-Handbuch oder dem Handbuch, das mit der RE
AKTOR Factory Selection ausgeliefert wird, über die Details zu Carbon 2.

3.4.1 Laden eines Snapshot
 

Spielen Sie einige Noten auf Ihrem MIDI-Keyboard, um sich einen Überblick über den 
Klang des Synthesizers zu verschaffen. Ändern Sie den Klang komplett, in dem Sie einen 
anderen Snapshot laden.
In der REAKTOR-Terminologie steht die Bezeichnung Snapshot für einen Sound, ein Pre
set oder ein Patch. Jedes Instrument kann Snapshots beinhalten, die beim Laden die Pa
rameterwerte des Instruments mit neuen Werten versehen und einen bestimmten Klang 
beinhalten.
Die Snapshots von Carbon 2 sind in der zentralen Steuerung im Hauptmenü erreichbar.
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Abb. 3.3 Die Snapshot-Steuerung

1. Klicken Sie auf die Snapshot-Steuerung, um ein Drop-Down-Menü zu öffnen. Das Me
nü enthält alle Snapshots des Instruments.

2. Wählen Sie den Eintrag In Deep.
3. Spielen Sie ein paar Noten, um den Unterschied zu hören.
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3.5 Anpassung des Klangs
 

In diesem Abschnitt erfahren Sie, wie Sie Klänge durch einfache Anpassung verändern 
können.

3.5.1 Effekte austauschen
 

Der Snapshot In Deep verwendet einen Delay-Effekt zur Erzeugung eines räumlichen 
Klangs. Gehen wir davon aus, dass Sie in Ihrem Song einen Raumklang dieser Art nicht 
benötigen: Tauschen Sie diesen Effekt aus, indem Sie auf den Delay Button klicken. An 
Stelle des Delays drücken Sie den Chorus Button, um eine Stereoverbreiterung zu generie
ren.

Abb. 3.4 Chorus- und EQ-Effekte im Effects tab aktiviert
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3.5.2 Änderung der Filterbewegung
 

Lassen Sie uns auch die Filterbewegung ändern.
1. Um die Filterbewegung zu ändern, wechseln Sie zum Source-Bereich auf der rechten 

Seite des Instruments in dem Sie den entsprechenden Tab anklicken.
2. Wählen Sie den LFO1 im unteren Teil des Source-Bereichs, indem Sie auch diesmal 

den entsprechenden Tab anklicken.
3. Klicken Sie auf den Drehregler Rate und ziehen Sie ihn nach oben, um seinen Wert 

auf 8 zu erhöhen.
4. Spielen Sie eine Note: Die Geschwindigkeit der Filterbewegung hat sich verdoppelt.

Abb. 3.5 Der LFO-Bereich nach vollzogenen Änderungen

3.5.3 Änderung der Filtereinstellungen
 

Um den Filter auszutauschen:
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1. Klicken Sie auf den Drehregler Resonance, der sich im zentralen Filterbereich des In
struments befindet und ziehen Sie ihn nach oben, bis er der Wert 0.5 angenommen 
hat. Dieser Vorgang sorgt für eine bessere Hörbarkeit der Bewegung.

2. Lassen Sie den Klang brillanter klingen, in dem Sie den Cutoff-Wert durch klicken 
und nach oben ziehen des entsprechenden Drehreglers, erhöhen.

Abb. 3.6 Der Filerbereich nach den vollzogenen Änderungen

3.6 Speichern Ihrer Einstellungen
 

Sie haben zwei Möglichkeiten die Änderungen, die Sie an dem Sound vorgenommen ha
ben, zu speichern.

▪ Speichern Sie die Projekt-Datei Ihrer Host-Anwendung: Das ist der gängigste Weg, wenn 
Sie Musik produzieren und die einzige Möglichkeit, wenn Sie REAKTOR im Player-
Modus verwenden. Wenn Sie auf diesem Weg speichern, wird Ihre Host-Anwendung 
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alle nötigen Informationen des REAKTOR-Plug-ins abfragen, um den gewünschten 
Sound wieder herstellen zu können und diese mit dem Host-Projekt abspeichern. 
Wenn Sie Ihr Host-Projekt erneut laden, wird REAKTOR den Status wieder herstellen.

▪ Speichern der Ensemble-Datei: Dieser Weg ist nur dann möglich, wenn Sie die Vollver
sion von REAKTOR verwenden. In diesem Fall erzeugen Sie eine modifizierte Kopie 
der Datei, die Sie zuvor in diesem Tutorial geladen haben. Sie können den modifizier
ten Sound in einem anderen Song wiederverwenden, indem Sie das veränderte Instru
ment an Stelle des Originals laden.

Lesen Sie bitte die Dokumentation Ihrer Host-Software, um Details zum Speichern von Host-
Projekten zu erfahren.

Um die Ensemble-Datei als Kopie des original Instruments zu speichern, wählen Sie den 
Eintrag Save As... aus dem Anwendungsmenü. Es öffnet sich ein Fenster, indem Sie den 
Ordner und Dateinamen auswählen können. Klicken Sie nach der Auswahl des neuen 
Speicherorts und der Eingabe des neuen Dateinamens auf den Save Button.
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4 Bearbeitung eines REAKTOR-Ensembles
 

In diesem Tutorial
▪ werden wir das existierende REAKTOR-Ensemble Junatik bearbeiten. Junatik besteht 

aus einem Synthesizer-Instrument und einem Delay-Instrument.
▪ Wir werden ein Reverb-Instrument in die Structure einfügen und mit dem Synthesizer 

verbinden.
▪ werden wir ein Delay-Instrument aus einer Structur löschen.
▪ werden wir mehr über das Snapshot-System von REAKTOR lernen.
▪ werden wir den Browser benutzen, um Junatik zu laden, aber auch um das Reverb-

Instrument einzufügen.

Wenn Sie den REAKTOR PLAYER verwenden, können Sie an dieser Stelle aufhören zu lesen. 
Nach dem Sie das Kapitel 2 und 3 gelesen haben, können Sie mit der Arbeit beginnen!

4.1 Wiederholung
 

Im ersten Tutorial haben wir gelernt, wie Snapshots erzeugt und mit Append gespeichert 
werden können. Wir haben außerdem unsere Arbeit mit der Funktion Save Ensemble As... 
gespeichert. Da wir diese Arbeitsschritte auch weiterhin benutzen wollen, sollten Sie viel
leicht noch mal einen detaillierten Blick in das erste Tutorial werfen, bevor wir die nächs
ten Schritte vollziehen.

Benutzung der REAKTOR Buttons
Nochmals zur Wiederholung: Im letzten Tutorial haben wir

▪ den Sidepane Button im Hauptmenü benutzt, um die Sidepane zuöffnen und zu schlie
ßen. Die Sidepane befindet sich dort, wo der Browser, die Snapshots, die Panelsets 
und die Properties Tabs untergebracht sind.

Abb. 4.1 Der Sidepane Button

▪ Klicken Sie auf den Browser Tab, um den Browser zu öffnen.
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Abb. 4.2 Der Browser Tab

▪ Klicken Sie auf den Snapshot Tab, um die Snapshot-Liste zu öffnen.

Abb. 4.3 Der Snapshot Tab

In diesem Tutorial lernen Sie etwas über die REAKTOR-Einstellungen. Außerdem erfahren 
Sie etwas über den Structure Button.

▪ Klicken Sie auf den Properties Tab, um die Eigenschaften der REAKTOR-Ensembles, -
Instrumente, -Macros, -Module usw. einzublenden.

Abb. 4.4 Der Properties Tab

▪ Klicken Sie auf den Structure Button, um die REAKTOR Structure einzublenden.

Abb. 4.5 Der Structure Button

Es ist hilfreich, wenn Sie sich mit diese Buttons und ihren Icons vertraut machen, da sie 
sehr nützlich sind, gerade wenn Sie später REAKTOR als Plug-in verwenden!

4.2 Den Browser zum Laden von Ensembles nutzen
 

Erneut wollen wir den Browser zum Laden eines Ensembles nutzen.
1. Klicken Sie auf den Sidepane Button , um das Sidepane zu öffnen.
2. Klicken Sie auf den Browser Tab, um den Browser zu öffnen.
3. Klicken Sie auf den Factory Button, um zur Factory Library zu navigieren.
4. Verwenden Sie den Ordner-Baum im oberen Teil des Browsers und navigieren Sie zu 

Ensembles > Classics > Synthesizer. Sie sollten jetzt eine Liste von Synthesizern im 
unteren Teil des Browsers sehen.

5. Im unteren Teil des Browsers doppelklicken Sie zum Öffnen auf Junatik.

Bearbeitung eines REAKTOR-Ensembles
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Abb. 4.6 Junatik im Browser-Fenster

4.3 Instruments innerhalb von Ensembles 
 

In diesem Abschnitt werden wir die Hierarchien von Ensembles und Instrumenten in RE
AKTOR kennenlernen.
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4.3.1 Das Junatik Panel im Überblick
 

Abb. 4.7 Junatik Synth mit eingeklapptem StereoTDelay

Sehen Sie sich Junatik genauer an. Sie können jetzt den Aufbau des Synthesizers Junatik 
erkennen. Unterhalb des Synthesizers können Sie etwas erkennen, das mit StereoTDelay 
bezeichnet ist. Um das Ensemble Panel übersichtlich zu halten, werden Instrumente oft
mals eingeklappt. Tatsächlich ist das StereoTDelay in Junatik eingeklappt.

▪ Klicken Sie auf den A Button unten rechts, um ihn zu öffnen. Durch klicken Sie auf 
den — Button neben A und B wird er zusammengeklappt.
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Abb. 4.8 StereoTDelay ausgeklappt

4.3.2 Der Unterschied zwischen einem Ensemble und einem Instrument
 

Bei dem zuvor betrachteten 2-Osc Synthesizer war das Delay ein interner Bestandteil des 
Synthesizers. In diesem Fall ist das Delay ein separates Instrument. In der REAKTOR-Ter
minologie kann ein Ensemble mehr als ein Instrument beherbergen. In diesem Fall gibt es 
zwei Instrumente, den Junatik Synthesizer und das StereoTDelay.
In der REAKTOR-Terminologie kann ein Instrument ein traditionelles Instrument sein, wie 
ein Synthesizer oder ein Sampler oder ein Effekt, wie beispielsweise ein Delay oder Hall, 
oder etwas ganz anderes, wie ein Sequenzer oder einfach nur ein Bild.
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Abb. 4.9 Junatik-Instrument

Abb. 4.10 Delay-Instrument
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Spielen Sie ein paar Noten und Sie werden den Synthesizer zusammen mit dem Delay hö
ren. Wählen Sie unterschiedliche Snapshots und hören Sie sich verschiedenen Sounds an. 
Da Junatik aus einem separaten Synthesizer und einem Effect-Instrument besteht, ist das 
Snapshot-System hier etwas anders aufgebaut.

4.4 Snapshot Master für Plug-ins und Snapshot-Hierarchien 
 

Wenn Sie in die obere Zeile des Ensembles schauen, sehen Sie ein Panel namens Ens - 
Junatik.

Abb. 4.11 Ensemble Panel

Auf dem Ensemble Panel sehen Sie den Snapshot-Number 83 – Berlin ambience II.

4.4.1 Snapshot-Hierarchien in den Properties
 

Um die Snapshot-Hierarchien zu verstehen, müssen wir uns mit den Properties auseinan
dersetzen. Um dieses zu tun, müssen Sie:
1. Doppelklicken Sie Ens - Junatik. Alternativ können auch auf den Properties Tab in der 

Sidepane klicken.

2. Klicken Sie auf den Function-Buton, um die Function-Seite der Junatik Properties an
zuzeigen.
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Abb. 4.12 Die Function Button

Abb. 4.13 Ensemble Properties mit angewähltem Recall by MIDI und Snapshot Master
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Schauen Sie sich die Properties unter Snapshot an, die Kästchen Recall by MIDI und Snapshot 
Master for PlugIn sind beide angehakt.

4.4.2 Recall by MIDI und Snapshot Master für Plug-ins
 

▪ Snapshot Master for PlugIn bedeutet, dass bei Änderungen des Snapshots im Ensem
ble (Master), die Snapshots für den Synthesizer und das Delay überschrieben werden. 
Anders gesagt, das Instrument Junatik und StereoTDealy verhalten sich als Slaves 
zum Ensemble, das als Master agiert.

▪ Recall by MIDI bedeutet, dass dieses Instrument Programm-Change-Befehle empfan
gen kann. Wenn der Master diese Funktion ebenfalls eingeschaltet hat und auf dem 
gleichen MIDI-Kanal Befehle empfängt, dann werden dessen Snapshots verwendet.

4.4.3 Snapshot Properties für das Instrument Junatik
 

Wenn Sie einmal auf das Junatik Panel klicken, werden Sie sehen, dass das Recall by Pa
rent Kästchen angekreuzt ist.

Abb. 4.14 Der Snapshot-Bereich der Junatik Instrument Properties mit angewähltem Recall by Parent

Diese Einstellung sorgt dafür, dass die Snapshots auf dem Ensemble Panel als Master-
Snapshots fungieren.
Probieren Sie unterschiedliche Snapshots aus und Sie werden feststellen, dass sich durch 
die Auswahl einiger (aber nicht aller) Snapshots des Junatik Instruments die Snapshots 
des StereoTDelay Instruments ebenfalls ändern. Laden Sie den Snapshot “24 – Pointer 
1”. Beachten Sie, dass dadurch für das StereoTDelay der Snapshot, 1 – Delay off aktiviert 
wurde. Wählen Sie jetzt andere Snapshots für das Junatik Instrument.
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4.4.4 Snapshot mit ausgeschaltetem REAKTOR-Schalter
 

Sie werden feststellen, dass die Snapshots des Junatik-Instruments ohne Delay-Effekt wie
dergegeben werden: Der Delay-Effekt ist ausgeschaltet, da sich der Schalter über dem Wet-
Regler beim Snapshot 1 des StereoTDelays in der Stellung Off befindet.

Abb. 4.15 Ausgeschaltetes Delay

Schalter wie diese sorgen nicht nur für eine Stummschaltung des Instruments, sondern 
auch für eine Einsparung an CPU-Leistung. Wenn Sie dieses Ensemble in einer DAW nut
zen und dabei auf die Effekte der DAW zurückgreifen, ist es sinnvoll, die Effekte des En
sembles abzuschalten.

4.4.5 Snapshot-Flexibilität
 

Sie haben selbstverständlich die Möglichkeit, die Snapshots des StereoTDelay-Instruments 
ändern zu können, ohne die Snapshots des Synthesizers verändern zu müssen. Sie haben 
bei der Verwendung mehrerer Instruments eine große Speicherflexibilität durch das Anle
gen individueller Snapshots und können zusätzlich mit dem Snapshot Master die Snaps
hots mehrerer Instruments gleichzeitig ändern!

4.5 Das Delay-Instrument durch ein Reverb-Instrument ersetzen
 

Der Junatik-Synthesizer hat uns soweit ganz gut gefallen, wir wollen aber jetzt einen Hall 
an Stelle des Delays ausprobieren. Das bedeutet, dass wir das Delay durch einen REAK
TOR-Hall ersetzen wollen.
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4.5.1 Öffnen der REAKTOR Structure
 

Um das tun zu können, müssen wir uns mit der Structure des Ensembles auseinanderset
zen.

▪ Klicken Sie auf den Structure Button in der Sidepane.

Abb. 4.16 Der Structure Button

Dieser Vorgang öffnet die Ensemble-Structure.

Abb. 4.17 Ensemble Structure von Junatik

Sie können erkennen, dass der Junatik-Synthesizer mit dem StereoTDelay verbunden ist. 
Der Ausgang L (links) und R (rechts) des Junatik ist mit den Eingängen L und R des Stere
oTDelays verbunden. Die Ausgänge L und R des StereoTDelays sind mit dem Audio-Out-
Ausgang verbunden.
Wir werden gleich den Browser nutzen, um ein Hall-Instrument in eine Ensemble-Structu
re einzufügen. Dieses wird mit dem Junatik-Instrument verbunden sein. Vor diesem Schritt 
müssen wir das StereoTDelay aus der Structure entfernen.
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4.5.2 Ein Instrument aus der Structure entfernen
 

Um das Delay aus der Structure dieses Ensembles zu entfernen,
1. Führen Sie unter Windows® einen Rechtsklick (Mac OS® X: Ctrl+Klick) auf dem Ste

reoTDelay im Structure-Fenster aus – hierdurch öffnet sich ein Kontextmenü.
2. Selektieren Sie Delete mit der Maus und klicken Sie darauf. Dieser Vorgang entfernt 

das Instrument aus der Structure.

Abb. 4.18 Entfernen eines Instruments.

Das Instrument StereoTDelay sollte jetzt verschwunden sein.
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4.6 Den Bowser für die Instruments-Suche benutzen
 

Wir möchten jetzt das Delay- durch ein Hall-Instrument ersetzen. Mit dem Browser soll 
"SpaceMaster.ism." geladen werden
1. Klicken Sie in der Sidepane auf den Browser Tab, um den REAKTOR Browser zu öff

nen.

2. Navigieren Sie in der Ordnerstruktur des Browsers zu Instruments > Effects.
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3. Klicken und Ziehen Sie Space Master 1 – Stereo.ism vom unteren Teil des Browsers in den 
Structure-Bereich. Dieser Vorgang fügt das Instrument in die Ensemble-Structure ein.
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Abb. 4.19 SpaceMaster wurde in die Structure eingefügt.

Sie können alternativ einen Rechts-Klick in der Structure ausführen und Instruments über ein 
Kontextmenü einfügen.
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Abb. 4.20 SpaceMaster in der Panel-Ansicht

4.7 Das Instrument mit dem Audio Out verbinden
 

Wir müssen jetzt den Junatik mit dem SpaceMaster-Hall und den Hall mit dem Audio-Out-
Modul verbinden.

4.7.1 Verbindungen herstellen
 

1. Klicken und halten Sie den L-Ausgang (oder den kleinen Punkt daneben) des Junatik 
Instruments und ziehen Sie die Maus bis zum L-Eingang des SpaceMaster. Bei die
sem Vorgang sollten Sie erkennen können, das ein Kabel mit der Maus gezogen wird 
und der Cursor die Form einer Hand angenommen hat. Wenn Sie den SpaceMaster L-
Eingang oder den Punkt daneben erreicht haben, lassen Sie die Maustaste wieder los.
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2. Wiederholen Sie diesen Vorgang für alle Verbindungen – verbinden Sie dabei auch die 
Ausgänge L und R des SpaceMasters mit den Eingängen 1 und 2 des Audio-Out-Mo
duls.

Wenn Sie mit Ihrer Arbeit fertig sind, sollte sich folgendes Bild ergeben:

Abb. 4.21 SpaceMaster mit Junatik und den Ausgängen verbunden

Jetzt schauen wir uns an, wie die beiden Instruments im Ensemble Panel aussehen.
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4.7.2 Instruments im Ensemble Panel neu positionieren
 

Durch den eben beschriebenen Vorgang kann es dazu kommen, dass das SpaceMaster-In
strument in dem Ensemble Panel oberhalb des Junatik-Instruments platziert wurde – soll
te das nicht der Fall sein, so können Sie diesen Abschnitt überspringen. Um die Positio
nen zu tauschen müssen Sie nur das Folgende tun:
1. Schalten Sie auf die Panel-Ansicht um, indem Sie auf den Panel Button in der Seiten

leiste klicken.

2. Klicken Sie auf das SpaceMaster Panel klicken Sie auf dessen Namen.
3. Klicken und ziehen Sie das Instrument unterhalb des Junatik und lassen Sie die 

Maustaste los – das Instrument sollte an der neuen Position einrasten. Jetzt ist der 
Junatik wieder an erster Position!

Bearbeitung eines REAKTOR-Ensembles
Das Instrument mit dem Audio Out verbinden

 

REAKTOR 5.5 - Erste Schritte - 55



Abb. 4.22 Junatik an erster Position

4.8 Wiederherstellen der korrekten Snapshot-Hierarchie
 

Das Einfügen des SpaceMaster-Instruments in die Structure hat die Snapshot-Hierarchie 
geändert. Wir müssen an dieser Stelle ein paar Änderungen vornehmen, um die Snapshot-
Master-Hierarchie wieder herzustellen – das Ensemble soll nach wie vor als Snapshot-Mas
ter für das Plug-in gelten. Wir müssen dazu die Properties des Junatik-Instruments und 
des SpaceMaster-Instruments bearbeiten.

Bearbeitung eines REAKTOR-Ensembles
Wiederherstellen der korrekten Snapshot-Hierarchie

 

REAKTOR 5.5 - Erste Schritte - 56



4.8.1 Öffnen der Instrument Properties
 

Zuerst muss das Junatik-Ensemble wieder zum Snapshot Master for Plug-In werden und 
die Aktivierung der Funktion Recall by Parent für den SpaceMaster erfolgen.
1. Klicken Sie auf den Properties Tab im Sidepane.

2. Klicken Sie auf die Kopfzeile Ens - Junatik. Dieser Vorgang öffnet die Junatik Ensem
ble Properties.

3. Klicken Sie auf den Function Button.

4. Setzen Sie einen Haken für die Funktion Snapshot Master for Plug-In im Snapshot-Be
reich.

5. Klicken Sie auf das SpaceMaster Panel- klicken Sie auf dessen Namen. Dieser Vor
gang öffnet die SpaceMaster Properties.

6. Aktivieren Sie die Funktion Recall by Parent.
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5 Erzeugen eines Synthesizers mit integriertem Sequenzer
 

In diesem Tutorial möchten wir einen Synthesizer inklusive eines Sequencers erzeugen.

5.1 Wiederholung und Überblick
 

Als wir uns das Junatik Ensemble angeschaut haben, haben wir gelernt, dass Junatik aus 
dem Synthesizer Instrument Junatik und dem StereoTDelay Instrument besteht. Wir wer
den jetzt ein Ensemble erzeugen, das zwei REAKTOR Instruments beinhaltet. Eines der 
Instruments wird der Sequenzer namens Monoliner sein, das andere das Synthesizer In
strument Soundschool Analog (oder ANALOG, als Kurzform).
Der Monoliner ist die Nachbildung eines klassischen, analogen Step-Sequencers mit drei 
Knopfreihen, während Soundschool Analog einen klassischen, semimodularen Analog-Syn
thesizer mit 2 Oszillatoren darstellt.
Wir werden jetzt alle benötigten Kabelverbindungen (MIDI und Audio) herstellen, damit 
der Sequenzer den Synthesizer triggern kann.

Erzeugen eines Synthesizers mit integriertem Sequenzer

 

REAKTOR 5.5 - Erste Schritte - 58



Abb. 5.1 Monoliner in Kombination mit Soundschool Analog (ANALOG)

5.2 Erzeugen des Synthesizer-Sequencer-Ensembles
 

Zu Beginn erzeugen wir ein neues Ensemble und fügen dort unsere Instruments ein.

5.2.1 Erzeugen eines neuen Ensembles
 

▪ Erzeugen Sie ein neues Ensemble, in dem Sie den Menü Button drücken und den Ein
trag File > New Ensemble auswählen.
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Abb. 5.2 New Ensemble im Global-Menü

Abb. 5.3 Das Panel eines neuen Ensemble.

Sie können den Tastaturkurzbefehl [Strg]+[N] auf einem Windows®-Rechner ([Cmd]+[N] un
ter Mac OS® X) benutzen, um ein neues Ensemble zu erzeugen.

5.2.2 Den Browser nutzen, um neue Instruments zu laden
 

1. Klicken Sie im Sidepane auf den Browser-Tab, um den Browser zu öffnen.
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2. Klicken Sie auf den Factory Button, um zur Factory Library zu navigieren.

3. Navigieren Sie in der Ordnerstruktur des Browsers zu dem Pfad Instruments > Se
quencers.

4. Ziehen Sie Monoliner.ism aus dem unteren Teil des Browsers in den Pane-Bereich auf 
der rechten Seite. Dieser Vorgang fügt einen Monoliner in Ihr Ensemble ein.
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Wir möchten jetzt den Browser dazu verwenden, Soundschool Analog zu laden.
1. Navigieren Sie in der Ordnerstruktur des Browsers zu Instruments > Synthesizers.
2. Scrollen Sie bis zum Eintrag Soundschool Analog.ism.
3. Klicken und ziehen Sie Soundschool Analog.ism in den Panel-Bereich auf der rechten Sei

te.
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Abb. 5.4 Einfügen von SoundSchool Analog in Ihr Ensemble

5.3 Aktivieren des Synthesizer-Sequencers
 

Damit der Sequencer in Aktion treten kann, müssen wir eine MIDI-Verbindung zwischen 
dem Monoliner und dem Soundschool Analog herstellen.
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5.3.1 Überblick über die Structure
 

Nach dem Laden sollte sich die Structure wie folgt darstellen:

Abb. 5.5 Ensemble Structure mit Monoliner und ANALOG

Wir können hier die Instruments Monoliner und ANALOG erkennen und ebenfalls das vor
gegebene leere Instrument, das mit dem Audio In und Audio Out verbunden ist. Entfernen 
Sie jetzt das nicht benötigte Instrument aus der Structure.

5.3.2 Entfernen des nicht benötigten Instruments
 

▪ Entfernen Sie das vorgegebene Instrument unter Windows® mit einem Rechtsklick 
(Mac OS® X: [Ctrl] + Klick) auf der Oberfläche des Instruments und durch Auswahl 
des Eintrags Delete im Pop-up-Fenster.
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Abb. 5.6 Entfernen eines Instruments durch das Auwahlmenü.

Wenn wir schon einmal hier sind, können wir auch gleich die Ausgänge L und R des ANA
LOG Synthesizers mit den Eingängen 1 und 2 des Audio Out verbinden.

5.3.3 Die Ausgänge des ANALOG mit dem Audio Out verbinden
 

Vielleicht können Sie sich daran erinnern, dass wir diesen Schritt bereits bei der Verbin
dung des Junatik-Synthesizers mit dem SpaceMaster-Hall vollzogen haben.
1. Klicken und ziehen Sie - bis ein Kabel eingeblendet wird - von L aus (oder dem 

schwarzen Punkt daneben) bis zum Eingang des ersten Audio Ausgangs oder bis zu 
dem schwarzen Punkt daneben und lassen Sie los. Es wird eine Verbindung herge
stellt.

2. Wiederholen Sie diesen Vorgang für den Ausgang R und den Eingang 2.
Ihre Structure sollte jetzt so aussehen:
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Abb. 5.7 ANALOG mit angeschlossenen Audio-Ausgängen.

Wie Sie erkennen können, haben wir das Master Instrument nicht entfernt, da es einen 
sehr nützlichen Master-Level-Fader besitzt. Schauen wir uns jetzt die beiden Instruments 
im Ensemble Panel an.

5.3.4 Überblick über Monoliner und ANALOG
 

▪ Schalten Sie auf die Panel-Ansicht Ihres Ensembles um, indem Sie auf den Panel But
ton klicken.

Abb. 5.8 Der Panel Button
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Abb. 5.9 Monoliner und ANALOG

Wie Sie sehen können, besitzt der Monoliner drei Knopfreihen, die zur Steuerung von Ga
te, Velocity und Pitch dienen. Der snc&pos Bereich auf der linken Seite steuert die Ge
schwindigkeit und Richtung der Sequencer-Wiedergabe sowie die Anzahl der Steps. Die 
weiteren Steuerungsoptionen schauen wir uns zu einem späteren Zeitpunkt an. Wichtig zu 
wissen ist, dass der Monoliner über einen integrierten MIDI-Ausgang verfügt!
ANALOG besitzt 2 Oszillatoren, einen Ring-Modulator, 2 Hüllkurven, einen LFO und ein 
integriertes Stereo-Delay.

5.4 MIDI-Verbindungen zwischen Instruments herstellen
 

Wie zuvor schon erwähnt, wurde der Monoliner dazu programmiert, MIDI-Daten an REAK
TOR-Synthesizer und externe Synthesizer zu senden! Um die MIDI-Verbindung in diesem 
Ensemble herzustellen, bedarf es eines weiteren Arbeitsschritts. Glücklicherweise ist die
ser mit wenigen Maus-Klicks erledigt.
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5.4.1 Nutzung der internen MIDI-Verbindungen
 

Um intern den MIDI-Ausgang des Monoliner Instruments mit dem MIDI-Eingang des ANA
LOG zu verbinden, müssen Sie Connect-Seite der Monoliner Properties öffnen.
1. Klicken Sie auf den Properties Tab im Sidepane.

2. Klicken Sie auf den Connect-Buton, um die Connect-Seite der Properties anzuzeigen.

3. Um eine MIDI-Verbindung zwischen dem Sequenzer und dem Synthesizer herzustel
len, müssen Sie das Aufklappmenü Select Instruments im MIDI-Out-Bereich der Connect-
Page lokalisieren. Klicken Sie auf das Aufklappmenü und wählen Sie den Eintrag 
ANALOG.

4. Um zu überprüfen, dass die Verbindung zustanden gekommen ist, öffnen Sie die Con
nect-Seite des ANALOG-Instruments. Klicken Sie auf die Kopfzeile des ANALOG, um 
das Instrument auszuwählen.
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5. Die Connect-Seite des ANALOG sollte jetzt im Sidepane zu sehen sein. Klicken Sie 
auf das Select Instruments Drop-Down-Menü im MIDI-In-Bereich der Connect-Seite. Der 
Menüpunkt Monoliner ist mit einem Punkt versehen.

6. Speichern Sie jetzt Ihre Arbeit durch Auswahl des Befehls Save Ensemble As... aus 
dem Hauptmenü. Das war’s, Sie können jetzt diese Sequencer/Synthesizer-Kombina
tion nach Belieben testen!

5.5 REAKTOR Start- und Stopp-Buttons
 

Die Start- und Stopp-Buttons in REAKTOR dienen zur Steuerung des Sequencers.

Überblick über die Start- und Stopp-Buttons
Die Start- und Stopp-Buttons befinden sich in der Main Toolbar oben in jedem Instrument, 
direkt neben der BPM-Anzeige.

Abb. 5.10 BPM/ Start/Stopp
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▪ Um den Sequenzer zu starten, klicken Sie mit der Maus auf den Start-Button. Der Se
quenzer beginnt mit der Wiedergabe und Sie erkennen zusätzlich auch optisch, dass 
er eingeschaltet wurde. Die MIDI-Aktivitätsanzeigen bestätigen eine bestehende MI
DI-Verbindung. Sie sollten jetzt außerdem auch Sounds aus dem Synthesizer hören 
können!

Abb. 5.11 MIDI-Aktivitätsanzeige

Pausieren und Zurücksetzen des Sequencer
▪ Mit einem einfachen Klick auf den Stopp-Button wird der Sequencer in den Pause-Mo

dus versetzt – wenn Sie die Wiedergabe erneut aktivieren, wird sie an gleicher Stelle 
wieder aufgenommen. Mit einem Klick auf den Stopp-Button wird der Sequencer an 
den Anfang des Pattern zurückgesetzt.

Erzeugen eines Synthesizers mit integriertem Sequenzer
REAKTOR Start- und Stopp-Buttons

 

REAKTOR 5.5 - Erste Schritte - 70



5.6 Detaillierter Blick auf den Monoliner
 

Sehen wir uns jetzt die Geschwindigkeits- und Richtungssteuerungen genauer an.

5.6.1 Richtung und Geschwindigkeit verändern
 

Dieser Sequencer ist sehr flexibel hinsichtlich der Wiedergabe von Pattern.
▪ Um die Wiedergaberichtung von vorwärts nach rückwärts zu ändern oder eine Zufalls

wiedergabe auszulösen, öffnen Sie die Liste mit den Wiedergaberichtungen durch Klicken 
auf das Pfeilsymbol. Sie können auf gleichem Wege die Geschwindigkeit ändern, in 
dem Sie auf das Sync-Menü klicken.

Abb. 5.12 Wiedergaberichtung

Erzeugen eines Synthesizers mit integriertem Sequenzer
Detaillierter Blick auf den Monoliner

 

REAKTOR 5.5 - Erste Schritte - 71



Abb. 5.13 Geschwindigkeit

In der Voreinstellung 1/16 wird ein Takt in 16-tel Noten unterteilt.

5.6.2 Anzahl der Steps, Step Offset und Shuffle/Swing
 

▪ Mit dem stps Knopf kann die Anzahl der Steps bestimmt werden – Werte zwischen 1 
und 16 können ausgewählt werden.

▪ Mit dm offs Knopf kann bestimmt werden, an welcher Stelle die Sequenz beginnt.
▪ Mit SHFL kann der Swingfaktor des Playbacks bestimmt werden. Probieren Sie eine 

Einstellung mit 6 Steps und einem Offset-Wert von 9 aus.

5.6.3 GATE, VELOCITY und PITCH Knöpfe und On/Off Buttons
 

▪ Mit der obersten Knopfreihe – mit GATE beschriftet – steuern Sie die Länge des jewei
ligen Triggers.

▪ Der Knopf am Ende besitzt eine Master-Funktion und bezieht sich übergreifend auf 
die Länge der Gates.

▪ Die nächste Reihe – mit VELO bezeichnet – programmiert die Lautstärke jedes Trig
gers. Auch hier gibt es einen Master-Lautstärkeregler.

▪ Die unterste Reihe – mit PITCH beschriftet – steuert die Pitch-Werte.
▪ Die Button-Reihe steuert den Ein- und Ausschaltzustand des Gates (an oder aus).
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Abb. 5.14 Master-Knöpfe

Abb. 5.15 Gate-An-/Aus-Buttons

5.7 Untersuchung der Snapshots-/Show-Hints-Funktion
 

Lassen Sie uns diese Sequencer- und Synthesizer-Kombination noch weiter untersuchen.

5.7.1 Untersuchen der Snapshots in Monoliner und Analog
 

Monoliner besitzt nur ein paar wenige Snapshots, die es aber wert sind, ausprobiert zu 
werden. Die größten Potenziale eines Sequencers liegen in den Richtungswechseln, Ände
rungen der Anzahl der Steps und der Offset-Werte, welche im Bereich der snc&pos Steu
erung bearbeitet werden können und große Variationsmöglichkeiten bieten. Sie können 
diese Werte durch Drücken des Buttons rnd! auch zufällig generieren lassen. Der ANALOG 
Synthesizer besitzt ein große Anzahl an Snapshots, die Sie nacheinander testen sollten, 
während eine Sequenz wiedergegeben wird.

5.7.2 Show/Hide Hints
 

Noch einmal möchten wir Sie darauf hinweisen, dass Sie die Hints-Funktion nutzen sollten, 
die durch Drücken des Hints Buttons aktiviert werden. Sie werden feststellen, dass Sie auf 
diese Weise vor allen Dingen im Bereich des Synthesizers mit sehr nützlichen Informationen 
versorgt werden, wenn Sie die Maus über einen Knopf oder Schalter bewegen:
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Abb. 5.16 Informationen über den FM-Knopf

Wenn Sie Ihre Arbeit abgeschlossen haben, denken Sie bitte daran, diese zu speichern!
Denke Sie daran, dass Sie den Save Ensemble Befehl dazu benutzen können, um eine vor
hergehende Version zu überschreiben. Alternativ können Sie mit Save Ensemble As eine 
neue Version unter anderem Namen speichern und somit die alte Version beibehalten.
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6 Erkunden des Samplers in REAKTOR 
 

In diesem Tutorial möchten wir uns den Memory Drum 2 näher anschauen, der sich sehr 
gut als Sample-Player für Drum-Kit-Samples eignet.

6.1 Wiederholung und Überblick
 

Nach dem wir uns zwei Synthesizer aus der REAKTOR Library angeschaut haben, wird es 
Zeit, sich einen Sample-Player genauer anzuschauen.

▪ Wir werden uns anschauen, wie man ein Sample aus einer Sample Map durch ein ei
genes Sample ersetzt.

▪ Außerdem lernen Sie, wie man ein Sample zu einer Map hinzufügt.
▪ Wir schauen uns an, wie Samples aus einer Map mit einem MIDI-Keyboard ausge

wählt werden können und wie ein Sample mit der Maus hörbar gemacht werden kann.
▪ Wir schauen uns das Sample-Mapping in REAKTOR an.
▪ Zum Schluss nehmen wir uns noch kurz die besonderen Funktionen des Memory 

Drum vor.
Auch hier möchten wir wieder den Browser verwenden, um den Memory Drum 2 zu laden.
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Abb. 6.1 Memory Drum 2

6.2 Den Browser verwenden, um Memory Drum 2 zu laden
 

1. Klicken Sie im Sidepane auf den Browser Tab, um den Browser zu öffnen.
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2. Navigieren Sie in der Ordnerstruktur zu Ensembles > New Additions > Sample Player.
3. Doppelklicken Sie auf dem Eintrag MemoryDrum2.ens, um diesen zu laden.

Abb. 6.2 Auswahl von Memory Drum 2 im Browser

Die Samples des Memory Drum 2 wurden so gemapped, dass C1 das erste Sample auslöst 
und mit jedem Halbtonschritt ein neuer Sound erklingt. Verschaffen Sie sich zunächst ein
mal einen Überblick über die gebotenen Sounds, in dem Sie verschiedene Tonhöhen auf 
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Ihrem Keyboard spielen. Möglicherweise sind Sie schon glücklich mit den gebotenen In
halten, möchten aber dennoch lieber eigene Samples verwenden? Um das tun zu können, 
öffnen Sie den Sample-Map-Editor.

6.3 Ersetzen und Bearbeiten von Samples in dem Sample-Map-Editor
 

Wir möchten jetzt den Sample-Map-Editor verwenden, um die Samples auszutauschen. 
Wir öffnen die Sample Map und benutzen die Funktion SEL BY KEY, damit wir mit unse
rem MIDI-Keyboard und der Maus die Samples in der Map wiedergeben können.

6.3.1 Öffnen der Map und Wiedergabe der Samples
 

1. Doppelklicken Sie auf die Wellenform des Samples. Der Sample-Map-Editor öffnet 
sich daraufhin. Alternativ können Sie auch den Sample-Map Button in der Sidebar nut
zen oder das Tastaturkürzel [F9].

2. Schalten Sie die Select-Sample-by-Key-Funktion ein, indem Sie den Key Button in der 
rechten oberen Ecke der Sample Map drücken. Jetzt können Sie die Samples mit Ih
rem MIDI-Keyboard auswählen.
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3. Klicken Sie auf den Sample-Vorhör-Button, um die Samples in ihrem Ausgangszustand 
anzuhören.

Abb. 6.3 Der Sample-Vorhör-Button

Lassen Sie uns ein paar Samples durch Ihre eigenen ersetzen. Lassen Sie uns das Snare-
Sample auf der MIDI-Note 48 ersetzen. Zuerst müssen wir dieses durch Drücken von C2 
auf Ihrem Keyboard auswählen.

6.3.2 Die Funktion Ersetzen in der Edit Sample Liste anwenden
 

▪ Öffnen Sie das Edit-Aufklappmenü oben links im Sample-Map-Editor und wählen Sie 
den Eintrag Replace.
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Abb. 6.4 Mit dem Menü-Eintrag Replace ersetzen Sie das ausgewählte Sample.

Dieses sollte den Ordner öffnen, den wir eingangs in den Dateipfaden der Preferences von 
REAKTOR festgelegt haben. In unserem Beispiel haben wir die Snare ersetzt, die sich auf 
der MIDI-Note 48 befunden hat.

6.3.3 Sample-Key-Split und Root-Note
 

Schauen wir uns das Sample genauer an.

Abb. 6.5 Clap CloseTheBook.wav wie im Sample-Map-Editor zu sehen
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L und R haben beide den Wert 48. Das bedeutet, dass das Sample über Key-Split auf die 
Taste 48 des Keyboards fixiert ist und eine für Drum-Sounds passende Einstellung ge
wählt wurde. Der Root-Key ist ebenfalls bei 48. Das bedeutet, dass das Sample in seiner 
originalen Tonhöhe wiedergegeben wird, wenn es auf die MIDI Note 48 gelegt wird.
Eben haben wir gesehen, wie ein Sample ersetzt wird, jetzt möchten wir ein neues Sample 
zu der Map hinzufügen.

6.3.4 Benutzung der Funktion Add in der Edit-Sample-Liste
 

1. Wir müssen jetzt herunterscrollen bis zum letzten Sample in der Liste, welches sich 
auf der MIDI-Note 77 befindet und den Namen Sound 9 trägt.

2. Klicken Sie auf das Edit-Aufklappmenü und wählen Sie den Eintrag Add.

Abb. 6.6 Hinzufügen eines neuen Samples zur Sample Map mit dem Menü-Eintrag Add
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Diesmal öffnet sich der zuletzt benutze Ordner, den wir verwendet haben, als wir ein be
stehendes Sample ersetzt haben. Sie können jetzt ein Sample aus diesem Ordner laden 
oder zu einem anderen Ordner navigieren. Führen Sie auch hier wieder einen Doppelklick 
auf das Sample aus, um es in die Map zu laden.

6.3.5 Key-Split bearbeiten
 

Wir möchten den Key-Split so ändern, dass L und R den gleiche Wert haben - 78. Um den 
Wert zu ändern:
1. Doppelklicken Sie auf die Nummer in der gewünschten Zeile und Spalte (in diesem 

Fall die entsprechende Zeile Ihres neuen Samples und die Spalte mit der Bezeich
nung R).

2. Tippen Sie eine neue Zahl ein.
3. Drücken Sie [Enter], wenn Sie fertig sind. Auf diesem Weg ist es recht einfach, neue 

Samples hinzuzufügen.

4. Experimentieren Sie mit weiteren Samples. Wenn Sie die Bearbeitung der Sample Map 
abgeschlossen haben und Sie diese schließen möchten, drücken Sie den Sample Map 
Button erneut. In diesem Abschnitt möchten wir uns das Memory-Drum-Interface 
noch weiter anschauen.

Abb. 6.7 Der Sample Map Button

6.4 Das Memory-Drum-Interface
 

Jede MIDI-Note kann nicht nur zur Auswahl von Samples genutzt werden, sondern sie 
kann auch sehr drastische Charakteränderungen für einen Sample Slot herbeiführen.
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6.4.1 Die Tonhöhe für einen einzelnen Sample Slot ändern
 

Lassen Sie uns zurückgehen zu dem Sample, das wir ersetzt haben und dessen Tonhöhe 
ändern. Mit dem Memory Drum können Sie die Tonhöhe eines Slots individuell ändern, 
ohne die anderen Slots zu verändern.

▪ Klicken Sie auf den p-Fader und ändern Sie die Tonhöhe auf einen niedrigeren Wert, 
indem Sie in die Mitte des Faders klicken und nach unten ziehen:

Abb. 6.8 Durch Veränderungen des p-Werts können Sie die Tonhöhe des Samples bestimmen.

Wenn Sie das Sample mit Ihrem Keyboard spielen, hören Sie jetzt die veränderte, tiefere 
Tonhöhe. Wenn Sie ein anderes Sample spielen, werden Sie feststellen, dass sich deren 
Tonhöhe nicht verändert hat. Diese Funktion macht den Sample-Drum-Player recht einzig
artig. Jeder Sample-Sound-Slot kann mit eigenen Parameterkombinationen ausgestattet 
werden. Probieren Sie die anderen Einstellungen ebenfalls aus und selektieren Sie unter
schiedliche Hüllkurven und Filter für jede Note.
Lassen Sie uns diese Möglichkeiten einmal näher begutachten.
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6.4.2 Erkunden der Memory Drum Snapshots
 

Abb. 6.9 Die Snapshots List der Memory Drum

Das voreingestellte Snapshot besitzt für jedes Drum-Sample die gleichen Einstellungen. 
Wählen Sie daher eines der anderen Snapshots, um sich abweichende Einstellungen anzu
hören. Sie werden feststellen, dass das Drücken von verschiedenen Tasten nicht nur ver
schiedene Samples auslöst, sondern das diese auch mit sehr unterschiedlichen Einstellun
gen versehen sein können. Bevor Sie Ihr Ensemble speichern, können Sie neue Samples 
hinzufügen und verschiedene Änderungen an den Einstellungen vornehmen. Wenn Sie Än
derungen an dem Snapshot vornehmen, sollten Sie das neue Snapshot unter einem ande
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ren Namen durch Drücken der Funktion Append speichern. Wenn Sie mit dem Hinzufügen 
und Austauschen von Samples fertig sind, denken Sie bitte daran, Ihre Arbeit mit Save 
Ensemble As... zu speichern. Wenn Sie das nicht machen, war Ihre ganze Mühe umsonst! 
In dem Tutorial in Kapitel↑8, Einen Sampler mit den REAKTOR-Modulen erzeugen, wer
den wir uns verschiedene Sample-Wiedergabe-Möglichkeiten anschauen, wie zum Beispiel 
umgekehrt, vorwärts/rückwärts und vorwärts/rückwärts-umgekehrt. Außerdem werden wir 
etwas über das Transponieren von Samples im Sample-Map-Editor erfahren.
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7 Einen Synthesizer mit Macros erzeugen
 

In diesem Tutorial werden wir einen analogen Synthesizer mit vorgefertigten Factory Mac
ros erzeugen. Der Synthesizer wird aus zwei Oszillatoren, einem Mixer, zwei Hüllkurvenfor
mern und einem Filter bestehen. Es wird vorausgesetzt, dass Sie sich mit den vorangegan
genen Tutorials auseinandergesetzt haben, die eine Reihe von Einfüge- und Verbindungs
techniken behandelt haben.

7.1 Was ist ein Macro?
 

REAKTOR 5 hat eine ganze Bibliothek an vorgefertigten Macros. Ein Macro beinhaltet eine 
Gruppe von Modulen, die bereits miteinander verbunden sind und sich selbst in einem ei
genen, übergeordneten Modul befinden, das nur über Ein- und Ausgänge verbunden wer
den muss. Ein Macro ist etwa mit einem Instrument vergleichbar, aber kleiner. Es ist wei
terhin auch vergleichbar mit einem Modul zur Konstruktion von komplexen Oszillatoren, 
Filtern, Hüllkurven-Formern, Delays, etc., das man beispielsweise in modularen Synthesi
zern findet. Wenn Sie sich eine Weile mit dem Bau von Synthesizern beschäftigen, sollten 
Sie Ihre Ideen als Objekte betrachten und abstrahieren, dass Module bestimmte Beziehun
gen haben und durch Macros umhüllt sind.
Unten sehen Sie einen fertigen Synthesizer, dessen enthaltene Macros durch Linien und 
Bezeichnungen von einander abgegrenzt sind.
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Abb. 7.1 Fertiger Synthesizer

Das Oszillator 1 Macro enthält 3 Oszillatoren in der Structure und Steuerungen für Pitch, 
Fine, P-Width und einen Wellenformumschalter. Dieses sind alles individuelle Module, die 
aber alle miteinander verbunden und in einem kleinen Ordner namens Macro zusammen
gefasst sind.
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Abb. 7.2 Oscillator Macro in der Structure-Ansicht

Fortgeschrittene Anwender verwenden oft Teile eines Ensembles, die mit einander in Verbin
dung stehen und fügen diese in neue Macros ein, um sie einfach wiederverwenden zu können.

7.2 Vorbereitung
 

Wir möchten im ersten Schritt ein neues Ensemble laden, das vorgegebene Instrument lö
schen und ein Instrument einfügen, das für den gewünschten Zweck geeignet ist.

7.2.1 Laden eines neuen Ensemble
 

Wir starten mit dem vorgefertigten New Ensemble von REAKTOR.
1. Drücken Sie den Menu Button und wählen Sie Menü-Eintrag File > New Ensemble.
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Es erscheint ein Ensemble Panel.

Abb. 7.3 Panel-Ansicht eines neuen Ensemble

▪ Drücken Sie den Structure Button, um die Structure einzublenden.

Abb. 7.4 Der Structure Button
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Abb. 7.5 Die Structure eines neuen Ensemble

Um zu starten, wollen wir mit der Structure arbeiten.

7.2.2 Entfernen des vorgegebenen Instruments
 

Unser Synthesizer soll mit einem einfachen Ausgang ausgestattet werden, wir brauchen al
so das vorgegebene Instrument mit zwei Ausgängen (links und rechts) nicht.

▪ Entfernen Sie das vorgegebene Instrument unter Windows® mit einem Rechtsklick 
(unter Mac OS® X: [Ctrl] + Klick) auf der Oberfläche des Instruments und durch Aus
wahl des Eintrags Delete im Pop-up-Fenster.
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Abb. 7.6 Entfernen des vorgegeben Instruments.

Wir müssen jetzt ein Instrument einfügen, dass sich für den gewünschten Synthesizerbau 
eignet, wir brauchen dazu ein Instrument mit nur einem Ausgang, da unser Synthesizer 
nur über einen Mono-Ausgang verfügen soll und nicht über einen Stereo-Ausgang.

7.2.3 Einfügen eines neuen Instruments
 

▪ Um ein neues Instrument einzufügen, führen Sie [Ctrl]+Klick (Mac OS® X) oder ei
nen Rechtsklick (Windows®) auf einer leeren Stelle der Ensemble Structure aus und 
öffnen Sie das Kontextmen. Wählen Sie in dem Menü den Eintrag Insert Instrument 
>_New – 1In1Out.

Einen Synthesizer mit Macros erzeugen
Vorbereitung

 

REAKTOR 5.5 - Erste Schritte - 91



Abb. 7.7 Einfügen eines neuen Instruments

Unser eingefügtes Instrument hat einen Eingang und einen Ausgang.
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Abb. 7.8 Eingefügtes Instrument in der Structure

Da wir für unseren Synthesizer nur den Ausgang benötigen, können wir den Eingang ent
fernen.
1. Doppelklicken Sie auf das Instrument, um es zu öffnen,
2. Führen Sie unter Windows® einen Rechtsklick (Mac OS® X: [Ctrl]+Klick) auf dem 

StereoTDelay im Structure-Fenster aus – hierdurch öffnet sich ein Kontextmenü. Kli
cken Sie dann auf den Menü-Eintrag Delete.

3. Doppelklicken Sie auf den Hintergrund der Structur, um sich zurück auf die oberste 
Ebene der Structure zu begeben.

7.2.4 Das Instrument mit dem Audio Out verbinden
 

Wir müssen jetzt den Ausgang des Instruments mit den Audio Outs 1 und 2 verbinden.
1. Platzieren Sie den Cursor auf Out – oder den kleinen Punkt daneben.
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2. Klicken und halten Sie die Maus gedrückt, während Sie diese auf den Eingang 1 des 
Audio-Out-Moduls ziehen.

3. Wenn Sie die 1 (oder den Punkt daneben) des Audio-Out-Moduls erreicht haben, las
sen Sie die Maustaste wieder los und eine Kabelverbindung sollte zu sehen sein.

Wiederholen Sie diese Schritte, aber verbinden Sie diesmal den Instrument-Ausgang mit 
dem Eingang 2 des Audio Out. Durch diesen Schritt wird der Sound auf beiden Ausgängen 
Ihres Audio-Systems hörbar gemacht. Ihre Verbindungen sollten wie folgt aussehen. Die 
gelbe Lampe in der rechten unteren Ecke des Instruments bestätigt die Verbindung!

Abb. 7.9 Das Instrument ist mit dem Ausgang verbunden.

7.3 Hinzufügen eines Oszillators und einer ADSR Env zu dem Instrument
 

Wir wollen jetzt ein Oszillator Macro und eine ADSR Env einfügen und die nötigen Verbin
dungen herstellen. Zusätzlich benötigen wir NotePitch und Gate Module, so dass wir den 
Synthesizer mit unserem MIDI-Keyboard spielen können.

7.3.1 Einfügen eines Oszillators
 

1. Stellen Sie sicher, dass Sie sich innerhalb des Instruments befinden. Um sich in ein 
Instrument zu begeben, führen Sie einen Doppelklick auf dem Instrument-Objekt aus.

2. Um ein Oszillator-Macro in eine Instrument Structure einzufügen, führen Sie unter 
Mac OS® X einen [Ctrl]+Klick und unter Windows einen Rechtsklick auf einer freien 
Stelle in der Instrument Structure aus und wählen Sie Macro > Building Blocks > Os
cillators > Osc (pls,saw, tri). Ein Osc 3 Wave erscheint darauf hin in der Instrument 
Structure und im Instrument Panel.
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3. Verbinden Sie in der Instrument Structure den Ausgang des Osc 3 Wave Macros mit 
dem Audio Voice Combiner durch Klicken und Ziehen, wodurch eine Kabelverbindung 
hergestellt wird, ähnlich wie wir es bei der Verbindung des Instruments mit den Audio 
Outputs gemacht haben.
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Abb. 7.10 Oszillator verbunden mit einem Audio Voice Combiner

7.3.2 Einfügen einer ADSR Env
 

▪ Führen Sie unter Mac OS® X einen [Ctrl]+Klick und unter Windows® einen Rechts
klick auf einer freien Stelle in der Instrument Structure aus und wählen Sie Macro > 
Building Blocks > Envelopes > ADSR – Env.
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Abb. 7.11 ADSR-Env einfügen

7.3.3 Einfügen von Pitch- und Gate-Modulen
 

Als nächstes müssen wir ein paar weitere Komponenten einfügen – in der REAKTOR-Ter
minologie als Module bezeichnet. Die Note-Pitch- und Gate-Module ermöglichen, dass der 
Synthesizer mit dem MIDI-Keyboard gespielt werden kann.
1. Führen Sie unter Mac OS® X einen [Ctrl]+Klick und unter Windows® einen Rechts

klick auf einer freien Stelle in der Instrument Structure aus und wählen Sie Built-In 
Module > MIDI In > Note Pitch, um ein Noten-Pitch-Modul in die Structure einzufü
gen.

2. Wiederholen Sie diesen Schritt und wählen Sie diesmal Built-In Module > MIDI In > 
Gate um das Gate-Modul zu laden.
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7.3.4 Verbinden des Pitch- und Gate-Moduls
 

Jetzt wird es Zeit, dass wir die notwendigen Kabelverbindungen herstellen, um unseren 
frisch gebackenen Synthesizer spielen zu können.
1. Mit den gleichen Klick- und Ziehtechniken, die wir zuvor angewendet haben, verbin

den Sie bitte das NotePitch Modul mit dem P (Pitch) Eingang des Osc 3 Wave Mac
ros.
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2. Verbinden Sie anschließend das Gate Modul mit dem G (Gate) Eingang des ADSR-Env 
Macros.

3. Zum Schluss müssen wir noch den oberen Ausgang der ADSR- Env mit dem A (Ampli
tude) Eingang des Osc 3 Wave Macros verbinden.

Unser Synthesizer sollte nun wie folgt aussehen:

Abb. 7.12 Ihr Synthesizer mit allen gewünschten Verbindungen

7.3.5 Ausgangspegel einstellen
 

Bevor wir mit dem Spielen unseres Synthesizers beginnen, sollten wir den Ausgangspegel 
einstellen.
1. Schalten Sie auf die Panel-Ansicht Ihres Ensembles um, indem Sie auf den Panel But

ton klicken.

2. Werfen Sie einen Blick auf das Master Instruments Panel und stellen Sie den Level 
Fader auf einen Wert von -10.

Abb. 7.13 Verwenden Sie das Master Instrument, um den Ausgangspegel einzustellen.
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Spielen Sie ein paar Noten und hören Sie, wie sich die Tonhöhe des Oszillators verändert 
und die Noten durch Drücken der Tasten gestartet und gestoppt werden!

7.4 Einfügen des Filters
 

Als nächstes möchten wir ein Filter-Macro einfügen.

7.4.1 Einfügen des Filter-Macros und weitere Verkabelungen
 

1. Stellen Sie sicher, dass Sie sich innerhalb der Instrument Structure befinden. Wenn 
Sie die Panels sehen, drücken Sie zuerst den Structure Button.

2. Doppelklicken Sie auf das Instrument Object, um seine Structure zu öffnen.
3. Führen Sie unter Mac OS® X einen [Ctrl]+Klick und unter Windows® einen Rechts

klick auf einer freien Stelle in der Instrument Structure aus und wählen Sie Macro > 
Building Blocks > Filters > 4 Pole Filter (BP, BLP, LP).

Jetzt möchten wir noch weitere Verkabelungen vornehmen.
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1. Verbinden Sie durch Klicken und Ziehen den Ausgang des Osc 3 Wave Macros mit 
dem In-Eingang des 4-Pole-Filter-Macros.

2. Verbinden Sie dann den Ausgang des 4-Pole-Filters mit dem Eingang des Audio Voice 
Combiner mit der Bezeichnung “}”.

Ihr Synthesizer sollte jetzt wie abgebildet aussehen:

Wir haben jetzt das Filter Macro in die Instrument Structure eingefügt. Jetzt sollten wir 
uns mit der Instrument-Panel-Ansicht auseinandersetzen. Sie werden feststellen, dass alle 
Macros direkt übereinander liegen. Dieses kann durch ein Entsperren des Panels behoben 
werden.

▪ Um das Instrument Panel anzuzeigen, drücken Sie den Panel Button.

Abb. 7.14 Der Panel Button

7.4.2 Entsperren des Panels, um Macros bewegen zu können
 

Nach dem Entsperren des Panels, können Sie die Macros verschieben, sodass sie nicht 
länger übereinander liegen.
1. Klicken Sie auf das Panel-Sperren-Symbol, um das Panel zu entsperren. Alternativ kön

nen Sie unter Windows® den Tastaturkurzbefehl [Strg]+[P] ([Cmd]+[P] wenn Sie un
ter Mac OS® X arbeiten) verwenden, um zwischen einem gesperrten und entsperrten 
Panel umzuschalten.
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Ihr Synthesizer sollte jetzt wie abgebildet aussehen:

7.5 Hinzufügen eines zweiten Oszillators und eines Mixers
 

Wir möchten jetzt einen zweiten Oszillator hinzufügen, um den Sound fetter zu machen. 
Zusätzlich werden wir einen Mixer installieren und die notwendigen Kabelverbindungen er
stellen.
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7.5.1 Hinzufügen eines zweiten Oszillators mit der Funktion Duplicate
 

Anstatt einen zweiten Oszillator einzufügen, werden wir den bereits vorhandenen duplizie
ren.

▪ Begeben Sie sich wieder zur Instrument Structure, und führen Sie unter Mac OS® X 
[Ctrl]+Klick bzw. unter Windows® einen Rechtsklick auf der Oberfläche des Osc 3 
Wave Macros aus, selektieren Sie Duplicate und klicken Sie darauf.

Abb. 7.15 Duplizieren eines Oszillators

Es erscheint eine Kopie direkt über dem vorhandenen Osc 3 Wave Macro.
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7.5.2 In den Properties das Oszillator-Macro umbenennen
 

Beide Oszillatoren haben den gleichen Namen, daher sollten wir sie umbenennen.
1. Führen Sie unter Mac OS® X [Ctrl]+Klick bzw. unter Windows® einen Rechtsklick auf 

dem oberen Teil Osc 3 Wave Macros aus und wählen Sie den Menüeintrag Properties. 
Dadurch öffnet sich der Properties Tab für dieses Macro.

2. Klicken und markieren Sie den Text im Bereich Label, tippen Sie "Oscillator 1" in das 
Textfeld und drücken Sie [Enter].

3. Wiederholen Sie diesen Vorgang für den anderen Oszillator und tippen Sie diesmal 
Oscillator 2.
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Abb. 7.16 Einen Namen in den Label-Bereich des Properties Tab eingeben.

7.5.3 Hinzufügen eines Mixers
 

Nachdem wir zwei Oszillatoren hinzugefügt haben, benötigen wir jetzt einen Mixer, um die 
Laustärkepegel justieren zu können. Wir brauchen dazu ein Amp/Mixer-Modul. Wir müssen 
weiterhin die notwendigen Kabelverbindungen herstellen und die Anzahl der Mixer-Eingän
ge erhöhen.

▪ Um einen Mixer einzufügen, führen Sie unter Mac OS® X [Ctrl]+Klick und unter 
Windows® einen Rechtsklick auf einer freien Stelle in der Instrument Structure aus 
und wählen Sie Built-In Module > Signal Path > Amp/Mixer.

Einen Synthesizer mit Macros erzeugen
Hinzufügen eines zweiten Oszillators und eines Mixers

 

REAKTOR 5.5 - Erste Schritte - 105



Abb. 7.17 Einfügen eines Mixers

Jetzt verbinden wir die Ausgänge des Oscillator 1 und 2 mit dem Mixer.
▪ Klicken und Ziehen Sie auf den Ausgang des Oscillator 1 und stellen Sie eine Kabel

verbindung zu dem In-Eingang des Mixer-Moduls her.
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Abb. 7.18 Oscillator 1 mit dem Mixer verbunden

7.5.4 Erhöhen der Mixer-Eingänge
 

Wie Sie sehen können, hat der Mixer nur einen Eingang. Trotzdem können wir eine zweite 
Verbindung herstellen.

▪ Um eine zweite Verbindung herzustellen, halten Sie unter Mac OS® X [Cmd]+Ziehen 
und unter Windows® [Strg]+Ziehen (das heißt, halten Sie [Cmd]/[Strg]) gedrückt, 
während Sie eine Verbindung vom Ausgang des Oscillator 2 zum grünen unteren Ende 
des Mixer-Moduls herstellen. Wenn Sie diese Stelle mit der Maus erreichen, wird eine 
Verbindung zu einem neuen Kanal hergestellt.

Nachdem Sie den Ausgang des Mixers mit dem 4-Pole Filter verbunden haben, sollte Ihr 
Synthesizer so aussehen:
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Abb. 7.19 Mixer mit beiden Oszillatoren und dem Filter verbunden

7.5.5 Fader hinzufügen und mit dem Mixer verbinden
 

An dieser Stelle möchten wir Fader hinzufügen, um die Lautstärken der Oszillatoren steu
ern zu können.

▪ Führen Sie unter Mac OS® X einen [Ctrl]+Klick bzw. unter Windows® einen Rechts
klick auf einem Lvl-Eingang des Mixer-Moduls aus und wählen Sie den Menüeintrag 
Create Control. Dieser Vorgang erzeugt einen Fader.

Abb. 7.20 Mit dem Kontextmenü eine Steuerung des Eingangs erzeugen.
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Abb. 7.21 Der angeschlossene Fader

Verfahren Sie analog mit dem zweiten Lvl-Eingang des Mixers, sodass Sie zwei Fader er
halten.

7.5.6 Mit Duplicate eine zweite ADSR-Env erzeugen
 

Bevor wir anfangen, etwas für Ordnung zu sorgen, wollen wir die ADSR-Env duplizieren, 
sodass wir sie als Filterhüllkurve verwenden können. Zur Erinnerung: Führen Sie unter 
Mac OS® X einen [Ctrl]+Klick und unter Windows® einen Rechtsklick auf dem ADSR-Env 
Macro aus und klicken Sie auf Duplicate. Nachdem Sie die den zweiten ADSR-Env-Macro-
Ausgang mit dem PM (Pitch Modulation) Eingang des 4-Pole Filters verbunden haben, 
sollte die Structure wie folgt aussehen:
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Abb. 7.22 Die Structure mit einer zweiten ADSR-Env

7.5.7 Verbindung des NotePitch-Moduls mit den ADSR-Hüllkurven und dem Filter
 

Einige der wichtigsten Verbindungen gilt es noch herzustellen. Das NotePitch-Modul muss 
noch mit den P (Pitch) -Eingängen der Macros verbunden werden. Dieses Vorgehen bildet 
die Charakteristik eines echten Instruments nach, bei dem höhere Noten mit mehr Obertö
nen und kürzerer Notenlänge erklingen.

▪ Um diese Funktion zu erhalten, klicken und halten Sie den roten Ausgang des Not
ePitch-Moduls und ziehen Sie ein Kabel zu allen P-Eingängen der Macros, einge
schlossen der ADSR-Env und des 4-Pole Filters. Ihre Structure sollte wie folgt ausse
hen:
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Abb. 7.23 Die zusätzlichen Verbindungen für das NotePitch-Modul.

7.5.8 Das Instrument Panel aufräumen
 

Jetzt ist es an der Zeit, etwas für Ordnung zu sorgen. Zur Erinnerung: klicken Sie auf das 
Panel-Sperren-Symbol, um das Panel zu entsperren.

Abb. 7.24 Der Panel Lock Button

Fassen Sie die Macros an den Titelleisten an. Wenn sich das Textfeld rot färbt, ist es se
lektiert. Sie können mehere Objekte gleichzeitig auswählen, in dem Sie einen Kasten da
rüber ziehen oder diese mit [Shift]+Click selektieren. Verschieben Sie die Macros so, dass 
sich folgendes Bild ergibt:
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Abb. 7.25 Das Panel Ihres Synthesizers nach der Neuanordnung der Macros.

Umbenennen der ADSR-Env
Wie Sie sehen können, haben wir 2 ADSR-Env Macros, die beide den gleichen Namen ha
ben. Wir sollten daher die zweite ADSR-Env umbenennen, sodass wir wissen, dass diese 
das Filter moduliert. Dazu nutzen wir die Properties des Macros.
1. Führen Sie in der Instrument Structure unter Mac OS® X einen [Ctrl]+Klick, und un

ter Windows® Rechtsklick auf dem ADSR-Env-Macro aus, das mit dem Filter-Macro 
verbunden ist und markieren und klicken Sie Properties.
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2. Klicken und markieren Sie den Text im Bereich Label, tippen Sie "Filter Env" in das 
Textfeld und drücken Sie [Enter].

7.5.9 Das Aussehen der Fader ändern
 

In REAKTOR können Sie das Aussehen der Fader so ändern, dass sie als Knöpfe erschei
nen. Knöpfe verbrauchen weniger Platz und sind dadurch manchmal vorteilhafter. Wenn 
Sie mit den Fader glücklich sind, können Sie diesen Abschnitt überspringen. Um das Aus
sehen zu ändern, müssen wir erneut die Properties von REAKTOR aufsuchen und den View 
Button drücken.
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1. Führen Sie unter Mac OS® X einen [Ctrl]+Klick, und unter Windows® einen Rechts
klick auf einem der Fader aus, um dessen Properties anzuzeigen.

2. Klicken Sie auf den View Button , um die View-Page zu öffnen.

3. Ändern Sie die Style-Auswahl von Vertical Fader auf Knob.

Einen Synthesizer mit Macros erzeugen
Hinzufügen eines zweiten Oszillators und eines Mixers

 

REAKTOR 5.5 - Erste Schritte - 114



4. Führen Sie die gleichen Schritte für den anderen Fader durch. Wenn wir schon an der 
richtigen Stelle sind, können wir die Knöpfe auch in Osc 1 Level und Osc 2 Level um
benennen.

7.6 Spielen des Synthesizers und Änderungen am Sound vornehmen
 

Jetzt können wir uns unseren Synthesizer näher anschauen, einige Filter- und Oszillator-
Einstellungen vornehmen und Snapshots speichern. Zum Schluss sollten wir unsere ge
samte Arbeit speichern.

7.6.1 Ändern der Oszillator-Wellenformen, des Filters und des Ausgangspegels
 

Möglicherweise kommt Ihnen der Synthesizer-Sound etwas dumpf vor. In diesem Fall ha
ben Sie die Möglichkeit, die Oszillator-Wellenform mit dem Wave-Schalter auszutauschen 
und eine Sägezahnwelle auszuwählen sowie die Filter-Cutoff-Steuerung im Uhrzeigersinn zu 
bewegen.
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Abb. 7.26 Geänderte Filter- und Oszillator-Einstellungen

▪ Zusätzlich sollten Sie auch den Ausgangspegel auf -20 einstellen.

Abb. 7.27 Ausgangspegel einstellen

7.6.2 Speichern eigener Snapshots
 

Probieren Sie verschiedene Mod-Amt-Knob-Einstellungen des Filters aus. Diese Einstellun
gen bestimmen, wie stark sich die Filter-Env auf die Modulation des Filters auswirkt. Ex
perimentieren Sie ebenfalls mit verschiedenen Einstellungen der A, D, S und R- (Attack, 
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Decay, Sustain, Release) Knöpfe in beiden Hüllkurven. Die Veränderungen der relativen 
Pitch-Werte und Lautstärken der beiden Oszillatoren ist ebenfalls eine sehr spaßbringende 
Angelegenheit! Wenn Sie eine Einstellung gefunden haben, die Ihnen gefällt, speichern 
Sie diese als Snapshot. Zu Erinnerung: Wir haben diesen Schritt schon ausführlich behan
delt, als wir uns den 2-Osc und den Junatik Synthesizer näher angeschaut hatten.
1. Klicken Sie im geöffneten Sidepane auf den Properties Tab.

2. Drücken Sie den Append Button am Ende der Snapshot-Liste.

3. Vergeben Sie einen Namen für den Snapshot und drücken Sie [Enter].

7.6.3 Speichern Sie Ihre Arbeit mit Save As
 

Wenn Sie einige Snapshots erzeugt haben, sollten Sie nicht vergessen, Ihre Arbeit zu spei
chern!

▪ Diesmal möchten wir einen Shortcut des Betriebssystems nutzen: Drücken Sie unter 
Mac OS® X [Shift]+[Cmd]+[S] und unter Windows® [Shift]+[Strg]+[S], um den Be
fehl Save Ensemble As... aufzurufen. Da wir mit einem neuen Ensemble begonnen 
haben, kann es sein, dass Sie Ihren Anwender-Ordner erneut aufrufen müssen.
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8 Einen Sampler mit den REAKTOR-Modulen erzeugen
 

Wir möchten jetzt einen Sampler mit den REAKTOR-Modulen konstruieren.

8.1 Wiederholung und Überblick
 

▪ Wir haben Samples während der Arbeit mit dem REAKTOR-Sampler Memory Drum 2 
bereits kennengelernt.

▪ Wir haben außerdem einen Synthesizer aus fertigen REAKTOR-Macros erzeugt.
▪ Jetzt möchten wir einen Sampler mit den REAKTOR-Modulen von Grund auf erstel

len.

8.2 Welche Art Sampler?
 

Wir bauen einen Sampler, der sich für die Wiedergabe von Back Vocal Loops, Drone Textu
res und Sound-Effekten usw. eignet.
Die Samples sollen vorwärts, umgedreht und vorwärts/rückwärts wiedergegeben werden.
Wir möchten das einfache Sampler-Modul von REAKTOR verwenden. Außerdem soll ein 
Hüllkurven- und Filter-Modul zum Einsatz kommen und die Steuerungen Attack, Delay, 
Sustain und Release der Hüllkurve sowie Cutoff und Resonanz des Filters.
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Abb. 8.1 Der fertige Sampler

8.3 Aufbau der Grundstruktur
 

Wir möchten unsere Konstruktion in gleicher Weise beginnen, wie bei unserem Synthesi
zer. Dazu starten wir auch hier mit der Erzeugung eines New Ensemble.

8.3.1 Laden eines New Ensemble
 

▪ Drücken Sie den Menu Button und wählen Sie Menü-Eintrag File > New Ensemble.
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Abb. 8.2 Erzeugen eines neuen Ensemble

In diesem Fall möchten wir ein vorgegebenes Stereo-In/Stereo-Out-Instrument verwenden. 
Dieses gibt uns die Möglichkeit, zu einem späteren Zeitpunkt den Sampler mit getrennten 
links, rechts Ausgängen zu versehen.

8.3.2 Einfügen des ersten Moduls
 

Wir möchten jetzt das Sampler-Modul gemeinsam mit den Pitch- und Gate-Modulen einfü
gen.
1. Öffnen Sie die Ensemble Structure durch Klicken des Structure Buttons.
2. Zur Erinnerung: Mit einem Doppelklick auf das Instrument in der Ensemble Structure 

öffnen Sie diese, um weitere Module einfügen zu können.
3. Führen Sie unter Mac OS® X einen [Ctrl]+Klick und unter Windows® einen Rechts

klick auf einer freien Stelle in der Instrument Structure aus und wählen Sie Built-In 
Module > Sampler > Sampler.
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4. Ergänzen Sie als nächstes das NotePitch- und Gate-Modul. Das Gleiche haben wir ge
macht, als wir den Synthesizer konstruiert haben. Wählen Sie Built-In Module > MIDI 
In > NotePitch und an der gleichen Stelle Built-In Module > MIDI In > Gate.

Ihre Structure sollte wie folgt aussehen:
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8.3.3 Einfügen der Hüllkurve
 

Als nächstes möchten wir eine ADSR Hüllkurve mit den Parameteren Attack, Decay, Sus
tain und Release einfügen.
Führen Sie unter Mac OS® X einen [Ctrl]+Klick und unter Windows® einen Rechtsklick 
auf einer freien Stelle in der Instrument Structure aus und wählen Sie Built-In Module-> 
LFO, Envelope > ADSR.
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Abb. 8.3 Einfügen eines ADSR-Moduls

8.3.4 Steuerungen für die Hüllkurve erzeugen
 

Zum Einfügen dieser Steuerungen wollen wir genauso verfahren wie beim Einfügen von Fa
dern für den Mixer unseres Synthesizers.
1. Zum Einfügen eines Attack-Faders für die Hüllkurve müssen Sie unter Mac OS® X 

[Ctrl]+Klick und unter Windows® einen Rechtsklick auf dem A oder dem roten Punkt 
daneben ausführen und Create Control auswählen.
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2. Wiederholen Sie diesen Vorgang für die Eingänge D, S und R der Hüllkurve.
Ihre Structure sollte wie folgt aussehen:

8.4 Verbindungen herstellen
 

Jetzt können wir den Sampler mit den Ausgängen verbinden und die Gate- und NotePitch-
Module durch klicken/halten und ziehen mit dem Sampler und der ADSR-Env verkabeln.
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8.4.1 Verbinden Sie den Sampler mit den zwei Audio-Voice-Combiner-Modulen.
 

1. Klicken Sie auf den Out-Punkt des Samplers, halten Sie den Maus-Button gedrückt 
und ziehen Sie ein Kabel zu dem linken Audio Voice Combiner.

2. Wenn Sie den schwarzen Punkt des Eingangs des Audio Voice Combiner erreicht ha
ben, lassen Sie die Maustaste wieder los. Das Kabel sollte jetzt angeschlossen sein.

3. Wiederholen Sie diesen Vorgang für den rechten Audio Voice Combiner.
Auch hier zeigt das gelbe Licht eine erfolgreiche Verbindung an!

Abb. 8.4 Der Sampler ist mit dem Audio Voice Combiner verbunden.

8.4.2 Verbinden der NotePitch- und Gate-Module
 

1. Klicken/halten Sie auf den roten Punkt des NotePitch-Moduls und ziehen Sie das Ka
bel zum P (Pitch) -Eingang des Samplers.

2. Lassen Sie die Maustaste wieder los, wenn Sie den roten Punkt erreicht haben.
3. Wiederholen Sie diesen Vorgang für das Gate-Modul, das mit dem Trig-Eingang des 

Samplers und dem G (Gate) -Eingang der ADSR-Env verbunden werden muss.
Ihre Structure sollte jetzt wie folgt aussehen:
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8.5 Laden eines Samples in den Sampler
 

Wir haben jetzt einen einfachen Sampler konstruiert, sollten aber ein Sample laden, um 
zu hören, dass er auch funktioniert.
Öffnen Sie als erstes den Sample-Map-Editor.

8.5.1 Öffnen des Sample-Map-Editors aus dem View-Menü
 

▪ Klicken Sie auf den Sample Map Button in der Sidebar.

Abb. 8.5 Der Sample Map Button

Es wird darauf hin der Sample-Map-Editor des Instruments eingeblendet.
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Jetzt befinden wir uns im Sample-Map-Editor und können dort auf die gleiche Weise 
Samples hinzufügen, wie wir es bereits beim Memory Drum 2 getan haben.

8.5.2 Hinzufügen eines Samples im Sample-Map-Editor
 

▪ Um ein Sample der Sample Map hinzufügen, klicken Sie auf das Edit-Aufklappmenü 
und wählen Sie Add.
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Abb. 8.6 Das Edit-Aufklappmenü öffnen, um ein Sample hinzuzufügen.

Dieser Vorgang öffnet Ihren Audio-Ordner. Navigieren Sie zu dem Speicherort Ihrer Vocal 
Loops, Sound FX oder Drone Textures. Nach einem Klick auf Open wird das Sample in der 
Sample Map platziert.

Abb. 8.7 Geladenes Sample

Wenn Sie jetzt auf Ihrem MIDI-Keyboard spielen, sollten Sie das Sample in unterschiedli
chen Tonhöhen hören können!
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8.6 Anordnung der Module ändern
 

Wir möchten jetzt die Module in der Structure neu anordnen und auch ihre Platzierung im 
Ensemble Panel.
Durch diesen Schritt wird die Structure besser erkennbar und wir schaffen so außerdem 
Platz für neue Module.

8.6.1 Bewegen von Modulen in der Structure
 

Lassen Sie uns zunächst die Structure etwas aufräumen, in dem wir Module anwählen und 
sie auf neue Positionen verschieben.
1. Wir beginnen mit einem [Shift]-Klick auf Note Pitch, Sampler, Audio Voice Combiner 

und die Ausgänge L und R.

2. Verschieben Sie die selektierten Module nach unten und nach links.
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8.6.2 Löschen von nicht benötigten Modulen
 

1. Da wir die Audio-Eingänge L und R nicht benötigen, können wir diese löschen.
2. [Shift]-Klick ausführen, um beide Module anzuwählen.
3. Führen Sie unter Mac OS® X einen [Ctrl]+Klick, in Windows® einen Rechtsklick aus, 

selektieren und klicken Sie dann Delete Selection, um die Module aus der Structure 
zu löschen.
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Abb. 8.8 Auswahl der Funktion Delete Selection

8.6.3 Entsperren Panel nutzen, um Knöpfe zu bewegen
 

Die Steuerungen für die ADSR liegen alle übereinander auf dem Ensemble Panel. Um die 
Knöpfe verschieben zu können, müssen wir das Panel entsperren.
1. Um das Instrument Panel anzuzeigen, drücken Sie den Panel Button.

2. Klicken Sie auf das Panel-Sperren-Symbol, um das Panel zu entsperren.

Einen Sampler mit den REAKTOR-Modulen erzeugen
Anordnung der Module ändern

 

REAKTOR 5.5 - Erste Schritte - 131



Ihr Instrument Panel sollte jetzt wie folgt aussehen:

Abb. 8.9 Aufgeräumtes Panel
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8.7 Hinzufügen von weiteren Samples und Änderung der Einstellungen
 

Die Idee, die wir mit der Konstruktion dieses Samplers verfolgt haben, ist die, dass ver
schiedene Sample-Loops über unterschiedliche Tasten ausgelöst werden sollen. Um das 
zu erreichen, müssen wir ein paar weitere Änderungen an der Sample Map vornehmen und 
weiter Samples ergänzen. Dazu müssen wir erneut den Sample-Map-Editor öffnen.

8.7.1 Die Sample-Map mit einem Doppelklick auf die Wellenform öffnen
 

Nach dem wir die Anordnung im Instrument Panel aufgeräumt haben, können wir einen 
Doppelklick auf die Wellenform ausführen, der den Sample-Map-Editor öffnet.

8.7.2 Einstellungen der vorhandenen Samples ändern
 

Bevor wir weitere Samples hinzufügen, wollen wir ein paar Änderungen an den bereits vor
handenen vornehmen. Der Hintergedanke dabei ist, dass wir unsere Samples so anordnen 
möchten, dass sie auf den weißen Tasten liegen und bei der MIDI-Note 48 beginnen.
Zuerst müssen wir überprüfen, dass unser Sample korrekt durch die MIDI-Note 48 ausge
löst wird. Wir möchten außerdem sicherstellen, dass das Sample ausschließlich durch die
se Note ausgelöst wird.

8.7.3 Änderungen am Key-Split und Root Key vornehmen
 

1. Wir wollen, dass unser Sample auf der originalen Tonhöhe wiedergegeben wird, wenn 
die MIDI-Note 48 gespielt wird. Dazu müssen wir die Einstellungen der Root Note von 
60 auf 48 ändern. Doppelklicken Sie das Zahlenfeld in der Root-Spalte und geben 
Sie den gewünschten Wert ein.

2. Da das Sample nur über diese Taste wiedergegeben werden soll, müssen wir noch den 
Single-Key-Modus aktivieren. Wählen Sie dazu den Single-Key-Mode-Eintrag aus dem 
Edit-Aufklappmenü aus.
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3. Jetzt können Sie den L und R Key-Split auf den Wert 48 mappen. Markieren Sie ein 
Sample, führen Sie einen Doppelklick in der entsprechenden Zeile und Spalte (L oder 
R) aus und tippen Sie den neuen Wert ein. Drücken Sie [Enter] auf Ihrem Computer-
Keyboard, wenn Sie damit fertig sind.

Das Sample wird jetzt nur über die MIDI-Note 48 ausgelöst und in seiner originalen Ton
höhe wiedergegeben.

Abb. 8.10 Remapping des Samples
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8.7.4 Hinzufügen weiterer Samples
 

Wir möchten jetzt ein weiteres Sample hinzufügen und über die MIDI Note 50 spielbar 
machen.
1. Benutzen Sie auch hier die Funktion Add aus dem Edit-Aufklappmenü, um ein Sample 

hinzuzufügen.
2. Ändern Sie das Sample Mapping so, dass der L und R Key-Split den Wert 50 besitzt.
3. Verfahren Sie wie eben beschrieben und fügen Sie zwei weitere Samples hinzu. Da 

auch weiterhin nur die weißen Tasten zum Einsatz kommen sollen, setzen Sie bitte 
den Root-Key und die Werte für L und R auf 52.

4. Setzen Sie für das vierte Sample den Root-Key-Wert und die Werte für L und R auf 
53.

Unsere 4 Samples werden jetzt durch die Tasten C2, D2, E2 und F2 ausgelöst – das ent
spricht den MIDI-Noten 48, 50, 52 und 53.
Unsere Sample Map sollte jetzt wie folgt aussehen:

Abb. 8.11 Vier Samples, die jeweils durch eine eigene Taste ausgelöst werden.

Wenn Sie möchten, können Sie weitere Samples auf die MIDI-Noten 55, 57, 59 und 60 
legen. In unserem Tutorial möchten wir an dieser Stelle mit der Sample-Wiedergabe fort
fahren. Sie werden erfahren, wie Sie die Wiedergaberichtung ändern können.

Einen Sampler mit den REAKTOR-Modulen erzeugen
Hinzufügen von weiteren Samples und Änderung der Einstellungen

 

REAKTOR 5.5 - Erste Schritte - 135



8.8 Rückwärtswiedergabe und weitere Wiedergabemöglichkeiten
 

Jetzt möchten wir uns anschauen, wie Rückwärtsloops erstellt und Samples transponiert 
werden können.

8.8.1 Loop- und Richtungs-Buttons
 

Unser Sampler ist zwar recht einfach gehalten, bietet aber trotzdem für jedes Sample ver
schiedene Wiedergabeoptionen. Sehen wir uns die gebotenen Funktionen im Sample-Map-
Editor einmal näher an. Unterhalb der Sample-Wellenform können Sie Knöpfe erkennen, 
die die Funktionen Loop, Rückwärts und alternierenden Loop auslösen.

Abb. 8.12 Buttons und Auswahlkästen für Loop, Reverse und Alternating Loop

Wie Sie sehen können, sind diese 3 Funktionen in der Voreinstellung ausgeschaltet.
1. Überprüfen Sie, das Key Button eingeschaltet ist, sodass wir unser MIDI-Keyboard zur 

Auswahl der Samples nutzen können. Lassen Sie uns mit dem Sample beginnen, das 
auf der MIDI-Note 48 liegt.
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2. Klicken Sie jetzt auf den Loop Button, dessen Hintergrund dadurch leuchtet.
3. Benutzen Sie Ihr MIDI-Keyboard, spielen Sie ein paar Noten auf denen die von Ihnen 

editieren Samples liegen und halten Sie eine Taste gedrückt. Sie sollten jetzt hören, 
dass das Sample in einer Loop-Schleife immer wieder von vorne wiedergegeben wird.

4. Aktivieren Sie die Funktion Reverse.

Sie sollten jetzt hören, wie das Sample in einer Rückwärts-Loop-Schleife wiedergegeben 
wird.
Das Aktivieren der Alternate-Funktion führt dazu, dass das Sample zuerst rückwärts und 
dann vorwärts wiedergegeben wird.

Probieren Sie weitere Kombinationen aus!
Jedes Ihrer 4 Samples kann mit unterschiedlichen Einstellungen versehen werden.

Sie können das gleiche Sample auch auf 4 Tasten verteilen und jeweils verschiedene Wieder
gabecharakteristiken wählen!

8.8.2 Transponierung eines Samples
 

Im Moment werden alle 4 Samples in ihrer originalen Tonhöhe wiedergegeben.
▪ Benutzen Sie die Root-Einstellungen, um die Tonhöhe zu verändern.

In unserem Beispiel haben wir das Sample um 7 Halbtonschritte nach unten transponiert, 
indem wir die Roote-Note um 7 Halbtonschritte erhöht haben.
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Abb. 8.13 Transponierung eines Samples

8.9 Einen Filter hinzufügen 
 

Jetzt möchten wir ein Filter in unseren Sampler einbauen und Steuerungen für Cutoff und 
Resonanz erzeugen. Wir möchten außerdem verschiedene Filtercharakteristiken wie High 
Pass, Band Pass und Low Pass ausprobieren.

8.9.1 Einen Filter in die Structure einfügen
 

Führen Sie unter Mac OS® X einen [Ctrl]+Klick bzw. unter Windows®, einen Rechtsklick 
auf einer freien Stelle in der Instrument Structure aus und wählen Sie Built-In Module > 
Filter > Multi 2-Pole.
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Abb. 8.14 Einen Filter einfügen

8.9.2 Filtersteuerungen erzeugen und Verbindungen herstellen
 

Wir erzeugen Steuerungen für den P (Pitch Cutoff) -Eingang und den Res (Resonance) -
Eingang.
1. Wie zuvor führen Sie unter Mac OS® X einen [Ctrl]+Klick und unter Windows® einen 

Rechtsklick auf den entsprechenden Eingängen aus und wählen Sie Create Control.
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2. Verbinden Sie jetzt den Ausgang des Samplers mit dem Eingang des Multi 2-Pole und 
den Ausgang des LP (Lowpass) Filters mit den beiden Audio Voice Combiner.

Ihre Structure sollte nach der Verschiebung der Module, um Platz zu gewinnen, ungefähr 
so aussehen:

Abb. 8.15 Filter in der Structure mit Steuerungen

8.9.3 Die Anordnung im Instrument Panel aufräumen
 

▪ Einmal mehr ist es notwendig, dass wir das Panel entsperren, sodass wir die Cutoff- 
und Resonanz-Knöpfe verschieben können. Nach der Verschiebung liegen sie nicht 
mehr länger übereinander auf der Sampler-Oberfläche.

Ihr Instrument Panel sollte jetzt so aussehen:
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Abb. 8.16 Aufgeräumtes Panel

8.9.4 Den Band- und High-Pass-Filter testen und Ihre Arbeit speichern
 

Für manche Samples eignen sich Band-Pass- oder High-Pass-Filter besser als Low-Pass-
Filter.
1. Bevor wir aber weitere Veränderungen vornehmen, drücken Sie bitte den Menu Button 

und benutzen Sie die Funktion Save Ensemble As..., um Ihr Ensemble zu speichern!
2. Nachdem Sie Ihre Arbeit gespeichert haben, können Sie mit unterschiedlichen Filter-

Ausgängen experimentieren. Klicken Sie in Ihrer Instrument Structure auf den Aus
gang BP des Multi 2-Pole und ziehen Sie ein Kabel zu den Audio Voice Combinern.
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3. Spielen Sie jetzt Ihr MIDI-Keyboard, ändern Sie die Filter-Einstellung und testen Sie 
auch verschiedene ADSR-Konfigurationen.

4. Zum Schluss müssen wir den HP-Ausgang mit den 2 Audio Voice Combinern verbin
den. Entscheiden Sie danach, welcher Filter-Ausgang für Ihre Zwecke am besten ge
eignet ist.

5. Speichern Sie Ihre Arbeit.
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8.9.5 Mit Save Ensemble Ihren bereits gespeicherten Sampler aktualisieren
 

Wir haben unsere Arbeit bereits mit Save Ensemble As... gespeichert und können sie da
nach mit Save Ensemble aktualisieren und überschreiben.

▪ Drücken Sie den Menu Button und wählen Sie Menü-Eintrag File > New Ensemble.

Abb. 8.17 Das Ensemble speichern

Wenn Sie möchten, können Sie das Filter mit einer Modifikation flexibler machen. Wenn 
Sie dieses Thema interessiert, lesen Sie den folgenden Abschnitt. Wenn Sie mit dem 
Sampler zufrieden sind, können Sie den nächsten Abschnitt überspringen!

8.10 Modifikation eines existierenden Samplers
 

Der folgende Abschnitt ist für alle Anwender interessant, die sich eine flexible Filtersekti
on für den gerade erzeugten Sampler wünschen.
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8.10.1 Überblick über Selectors und deren Überblendfunktion
 

Einige von Ihnen wünschen sich vielleicht eine Möglichkeit, zwischen drei Filtercharakte
ristiken überblenden und so ganz bequem zwischen High-Pass, Band-Pass und Low-Pass 
umschalten zu können, um zu testen, was am besten zu den Samples passt. Wenn Sie das 
interessiert, sollte ihre fertige Structure wie folgt aussehen.

Abb. 8.18 Structure mit Selector-Modul

Wie Sie erkennen können, hat der Selector drei Eingänge und einen Position Fader.
Der Position Fader dient zum Überblenden zwischen den drei Filtern und verläuft vom 
High-Pass über den Band-Pass hin zum Low-Pass. Die Überblendungen verlaufen sehr 
gleichmäßig, sodass es möglich ist, Mischungen aus Filtercharakteristiken zu wählen und 
beispielsweise ein High-Pass-Filter gemischt mit etwas Band-Pass-Filteranteil zu erhalten. 
Lesen Sie im Folgenden, welche Schritte dazu nötig sind.

8.10.2 Selector einfügen
 

Fügen Sie ein Selector Modul ein und verbinden Sie die 3 Ausgänge der Filter damit. An
schließend müssen wir einen Position Fader kreieren und mit dessen Ausgang mit den 2 
Audio Voice Combinern verbinden.

▪ Führen Sie unter Mac OS® X [Ctrl]+Klick und unter Windows® einen Rechtsklick auf 
einer freien Stelle in der Instrument Structure aus und wählen Sie Built-In Module > 
Signal Path > Selector/Scanner.
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Abb. 8.19 Selector-Modul einfügen

8.10.3 Anschließen der Filter-Ausgänge
 

1. Im ersten Schritt müssen Sie den HP-Ausgang des Filters mit dem 0-Eingang des Se
lector verbinden.

2. Klicken Sie auf den schwarzen Punkt neben dem HP-Ausgang und halten Sie die 
Maus gedrückt, während Sie das Kabel zu dem Selector spannen.

3. Wenn Ihr Cursor den blauen Punkt neben dem 0-Eingang erreicht hat, dann lassen 
Sie die Maustaste wieder los und die Verbindung wurde hergestellt.
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Der Selector Eingang wird schwarz und signalisiert damit, dass eine Audio-Verbindung er
stellt wurde.

Abb. 8.20 Filter und Selector sind miteinander verbunden.

8.10.4 Erhöhung der Anzahl der Selector-Eingänge
 

Wir benötigen noch weitere Eingänge für den Selector, damit alle 3 Filter-Ausgänge ange
schlossen werden können.
1. Anstatt ein Kabel vom BP-Ausgang zum Selector zu ziehen, können Sie unter Mac 

OS® X die [Cmd]-Taste oder unter Windows® die [Strg]-Taste gedrückt halten.
2. Wenn wir den Selector unterhalb der zuvor gezogenen Verbindung erreicht haben, 

wird ein neuer Eingang hergestellt!
3. Wiederholen Sie diesen Schritt und verbinden Sie den LP-Ausgang mit einem dritten 

Selector-Eingang:
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Abb. 8.21 Selector-Eingänge sind mit den Filter-Ausgängen verbunden.

8.10.5 Hinzufügen des Position Faders und Änderung seines Auswahlbereichs
 

1. Um einen Fader zum Selector hinzuzufügen, führen Sie unter Mac OS® X einen [Ctrl]
+Klick und unter Windows® einen Rechtsklick auf dem Pos-Eingang des Selector 
aus, markieren Sie und klicken Sie auf Create Control.

2. Sie müssen den Auswahlbereich des Faders in den Properties einstellen. Um zu die
sem Bereich zu gelangen, führen Sie einen Doppelklick auf dem Fader in der Structu
re aus.
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3. Öffnen Sie die Function Page der Fader-Eigenschaften, indem Sie auf den Function But
ton klicken.

4. Ändern Sie jetzt den Maximalwert auf 2.

Der Position Fader bewegt sich jetzt zwischen den Werten 0, 1 und 2. Im Ergebnis bewegt 
er sich damit zwischen den 3 Filter-Ausgängen.

8.10.6 Letzte Verbindungen und Panel-Darstellung
 

Zum Schluss müssen wir den Selector mit den 2 Audio Voice Combinern verbinden.
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▪ Klicken, halten und ziehen Sie noch einmal ein Kabel zu den Eingängen der Audio 
Voice Combiner.

Nach der Herstellung der beiden Verbindungen und der Verschiebung des Selectors, sollte 
die Structure wie folgt aussehen:

Abb. 8.22 Alle Verbindungen hergestellt

▪ Abschließend müssen wir das Instrument Panel entsperren, um den Fader zu ver
schieben. Klicken Sie dazu auf das Panel-Sperren-Symbol und ziehen Sie den Pos 
Fader nach rechts.

Abb. 8.23 Der Panel Lock-Button.
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Abb. 8.24 Verschobener Position Fader.

▪ Verriegeln Sie das Panel, indem Sie erneut auf den Panel Lock Button drücken.

8.10.7 Entdecken Sie Ihren Sampler und fertigen Sie Snapshots an
 

1. Nehmen Sie Veränderungen an Ihrem selbst gebauten Sampler vor und speichern Sie 
diese als Snapshots.
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2. Denken Sie daran, dass Sie den Snapshot Tab drücken müssen und mit Append Ihre 
Snapshots speichern.

Abb. 8.25 Der Snapshot Tab

Abb. 8.26 Benutzen Sie Append
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Wie Sie wissen, müssen Sie Ihr Ensemble noch einmal speichern, um Ihre neuen Snaps
hots speichern zu können. Sie können Save Ensemble benutzen. Wenn Sie eine ältere Ver
sion Ihres Samplers, vielleicht eine ohne Selector, weiterhin aufheben möchten, können 
Sie mit Save Ensemble As... eine neue Version unter geändertem Namen speichern.
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9 Wie geht es weiter?
 

Jetzt, wo Sie die kompletten Tutorials in dem REAKTOR Getting-Started-Handbuch gele
sen haben, können Sie sich fortgeschritteneren Techniken zuwenden, in dem Sie die an
deren Handbücher studieren, die sich im Lieferumfang von REAKTOR befinden. Alternativ 
können Sie sich auch direkt an das REAKTOR-User-Forum auf unserer Webseite wenden, 
um dort die neuesten Tipps zu erfahren und sich mit einer wachsenden Anzahl wunderba
rer Instrumente und Ensembles eindecken.
Im welche Richtung Sie auch immer gehen, wir wünschen Ihnen viel Spaß mit REAKTOR 
und vergessen Sie nicht, Ihre Kreationen mit unserer User Community zu teilen!
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